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ABSTRACT 
 

 
 

Adam Hall: Material and Device Investigations On A Carbon Nanotube-Based Torsional 

Nanoelectromechanical System  

(Under the direction of Dr. Sean Washburn) 
 

 
The experiments in this thesis present a foundational study of a 

nanoelectromechanical system that demonstrates high potential for use in a wide range of 

applications. This system incorporates an individual carbon nanotube as a torsional spring 

for a lithographically defined, nanometer-scale metal mass suspended above a substrate.  

Fabrication and operation of such a device is discussed. Investigations are then 

performed to elucidate a variety of material and device characteristics. First, the shear 

(twisting) modulus of an individual singlewall carbon nanotube is measured. This is done 

through a combination of direct electrostatic actuation and computer modeling. Next, the 

theoretical dependence of singlewall carbon nanotube transport properties on torsional 

strain is confirmed experimentally. Finally, the device is used as a self-sensing resonant 

oscillator. The characteristics of such a device and the implications of all results are 

discussed, as are future directions. 
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It’s a magical world, Hobbes, ol’ buddy… 
Let’s go exploring! 

 
-Calvin 

from Calvin & Hobbes 



 
 
 
 
 

Chapter 1 
 

Introduction 
 

I don't know how to [miniaturize a computer] in a practical way, but I do know that 
computing machines are very large… Why can't we make them very small, make them of 
little wires, little elements---and by little, I mean little. For instance, the wires should be 
10 or 100 atoms in diameter, and the circuits should be a few thousand angstroms 
across.  
 

-Richard P. Feynman, 1959 
 
 
1.1 Motivation 

 
 
In 1959, Dr. Richard Feynman of the California Institute of Technology 

recognized that technology didn’t have to take up the space that it did. At the time, 

though, just getting a computer to work was a feat unto itself. The first field effect 

transistor (or at least the first FET-like device) had been developed by J. E. Lilianfeld in 

as early as 1925 (Fig. 1.1a), but 34 years later, silicon technology had only begun to 

allow realization of a working device. Integration into systems was still years away. 

Electrical computing technology still depended on the vacuum tube, which made it bulky 

(Fig. 1.1b). The “compact” technology of the day was the black and white home 

television. Clearly, science had a number of things to work on before worrying about 

getting smaller, especially to the degree that Dr. Feynman was suggesting.  

But, it wouldn’t be long before the idea was no longer relegated to the realm of 

science fiction. The advent of integrated circuit (IC) technology in the 1960’s, which 

combined the burgeoning field of silicon processing with much improved transistor 
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performance to great success, made it possible to realize large numbers of electrical 

circuit devices over a small area.  The question was no longer whether miniaturization 

was possible, but in what ways the technology would benefit from it.  Aside from merely 

taking up less space, what would there be to gain from targeting length scales like those 

postulated by Feynman?  

 

 

Figure 1.1 (a) Figure 1 from J. E Lilianfeld’s first patented FET-like device (US Patent 
#1745175). (b) An example of a vacuum tube computing system (image from 
www.columbia.edu/acis/history) 

 
 
The answer quickly made itself apparent in computational technology. Hundreds 

of memory-storing devices on one small chip was impressive for the first IC, but storing 

larger amounts of information would require larger numbers of devices, and each one 

requires a certain amount of power to operate. Although the power consumption for a 

single device may be small, the total amount added up quickly when multiplied over 

extremely large numbers, resulting in unreasonably high power requirements per chip. 

Further, the low efficiency of transistor devices resulted in a high heat loss, making rising 

temperatures another factor. In high ambient temperature ranges, the devices cease to 

function properly. Each of these hurdles could be positively affected by miniaturizing the 
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technology; smaller individual devices would require lower power to run and have less 

surface area from which to generate heat. 

But, the benefits of technology miniaturization in general would be greater and 

more wide-ranging than such mere practicality. For example, device physics acts very 

similarly and predictably over a large range of macroscopic length scales, but at scales 

approaching the molecular level, quantum effects begin to be less masked by bulk 

properties. This reveals a whole array of new material characteristics to exploit in new 

devices. In biologically relevant technology, decreased size can result in much higher 

sensitivity, meaning that the technology can interact with entities involved in basic 

biological functions or with entities that are detrimental to those functions.  

This is the length scale that is being explored by the present state of the art 

nanotechnology and is the subject of the current thesis, which will investigate one 

specific nanometer-scale device. It is built on a single carbon nanotube; “a wire… 10 or 

100 atoms in diameter”. This brings us closer than ever to realizing the fantastic idea 

postulated by Dr. Feynman nearly half a century ago. 

 

1.2 An Introduction to Carbon Nanotubes 
 
 
Since their 1991 discovery[1], carbon nanotubes (CNT) have been the darling of 

nanotechnology. Their use has been suggested in everything from electrical circuitry to 

the “space elevator”- an Earth-bound tether for a geosynchronous satellite. While their 

infinite utility may be somewhat overblown, the motive for such widespread interest is 

sound. This is indeed a unique material. 
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Essentially, CNT are a single, atomically thin graphitic layer rolled up on itself 

such that the hexagonal lattice structure is maintained circumferentially. Being only one 

atomic layer, this formation is energetically favorable only for small tube diameters, on 

the order of a single nanometer, but the length in the axial dimension is limitless, making 

the material molecular scale in one dimension and potentially macroscopic in another. 

Furthermore, an ideal CNT with few defect sites will be both mechanically strong and 

chemically inert. 

 

 

Figure 1.2 The carbon nanotube chiral structure, as related to the crystal lattice of 
graphite. Any nanotube can be mapped to a lattice point rolled over to meet (0,0). Also 
noted are the metallic or semiconducting behavior of a given lattice point (discussed in 
section 1.4) 

 
CNT are often characterized by their chiral vector, C, which is defined by the sum 

of an integer number of lattice vectors a1 and a2 on the Bravais lattice (Fig. 1.2): 
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! 

C = m " a
1
+ n " a

2
    (Eq. 1.1) 

In effect, this relation means that the point (m,n) can be rolled to meet the origin (0,0) and 

form the cylinder of the CNT. More commonly used than C to define a nanotube is the 

wrapping angle θ, or the angle at which C wraps about the tube axis (compared to the 

uniaxial vector). The relation between θ and the lattice point (m,n) is 

! 

" = tan#1 3m /(m + 2n)[ ]    (Eq. 1.2) 

It is notable that all CNT can be mapped to a chiral angle in this range of 0º-30º due to 

symmetry in the lattice structure. In other words, a (4,3) nanotube is just a (3,4) nanotube 

turned on its head. 

As a consequence of mapping to the hexagonal graphitic lattice, the lattice point 

(m,n) is also correlated with the diameter dt of the nanotube. This relation is given by 

! 

d
t

=
3a

c"c m
2 + n2 + mn( )

1
2

#
    (Eq. 1.3) 

where ac-c is the carbon-carbon bond length (1.42 Å). Hence, CNT come in a variety of 

clearly defined types, each interrelated yet possessing distinct geometrical values.  

CNT can also exist as either an individual tubule or as a series of concentric 

tubules, each having its own distinct properties. Tubes made of only one layer are thus 

referred to as single-wall nanotubes (SWNT) and those made of any number of coaxial 

layers are collectively referred to as multi-wall nanotubes (MWNT). Practically, MWNT 

are somewhat easier to incorporate into experiments, due to their larger diameter (on the 

order of tens of nm). However, as will be shown in coming sections, they also exhibit 

decidedly less interesting properties when compared to their single layer counterparts. 
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1.3 Carbon Nanotube Mechanical Properties 
 
 
Carbon atoms in a CNT share sp2 bonds, like those found in planar graphite and 

fullerenes. As each atom is covalently bonded to three nearest neighbors, the resulting 

structure is incredibly robust. Theoretical work[2] expected that a SWNT would have a 

Young’s modulus of ~1 TPa and a shear modulus of ~0.5 TPa. MWNT values would 

vary depending on the number of shells that comprise it, but values were expected to 

reach a Young’s modulus above 1.1 Tpa and a shear modulus of more than 0.55 Tpa. 

Experimental measurements on diamond[3] (along the cube axis) has yielded values of 

1.06 and 0.58 TPa, respectively.  

A variety of experimental work[4-9] has been done to confirm these values. 

Results for the Young’s modulus range from 0.4 to 4 TPa, in rough agreement with 

theory (owing for possible defect sites, mechanical losses and measurement error). These 

experimental results will be discussed in greater detail in Ch. 3. Furthermore, 

manipulations of individual CNT[10] have demonstrated that they exhibit little to no 

signs of wear or fatigue despite repeated application of large amounts of strain. This 

robust behavior makes the material ideal for a host of applications including scanning 

probe tips[11], composites[12, 13] and nanomechanical systems.   

Scanning probe force measurement techniques have also been used to directly 

measure the shear modulus of MWNT[14] using a fabricated metal pad as a lever 

arm[15]. The values garnered here were around 0.4 TPa, in agreement with theoretical 

expectations[2]. Previous experimental work has been unable to measure shear modulus 

in SWNT. This is the subject of work presented later in this thesis (Chapter 4). 
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1.4 Electrical Transport in Carbon Nanotubes 
 
 
As discussed previously, lattice continuity in the CNT tubule formation can be 

achieved with the carbon atoms spiraling about the axis at any number of angles with 

respect to the diameter. While these different varieties possess slightly different 

dimensions, the greatest distinction amongst them is found in their transport properties.  

Amazingly, SWNT of slightly different chirality can have radically different band 

structure- ranging from conductivity as high as copper to as wide a band gap as bulk 

silicon[16]. This has made the material especially attractive to nanotechnology as 

electrical or electromechanical components and much experimental work has been 

performed to this end, notably toward utility as field-effect transistors[17]. 

For obvious reasons, CNT band structure is related closely with that of an 

individual sheet of planar graphite, known as graphene. Graphene is known as a semi-

metal, not being uniquely classifiable as an insulator, semiconductor or pure metal due to 

the two-dimensional confinement of carrier mobility in the graphitic plane combined with 

the specific rotational symmetry of the lattice structure. The k-space representation of the 

lattice is a hexagon containing two lattice points (Fig. 1.3a) and the energy structure of 

the conduction (π) and valence (π*) bands with respect to this k-space representation 

result in points of energy minima and maxima, respectively (Fig. 1.3b). These points 

(called K points) occur at the six vertices of the hexagonal k-space lattice representation 

and meet between bands at the Fermi energy, EF. Importantly, the energies recede from 

EF in a conical shape (known as a dispersion relation, E(k)) and electronic states that 

approaching the Fermi level follow this shape. 
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Figure 1.3 (a) The k-space representation of the graphene lattice (red outline) atop the 
Bravais lattice. (b) The shapes of the graphene π and π* energy bands in k-space. Also 
shown is the energy projection onto a 2D plane and the K points. (b) from [18]. 

 
The cylindrical shape of the CNT imposes an additional circumferential boundary 

condition on the electron wave function and further limits the allowed propagation of 

carriers traveling down the tube axis. This gives rise to one-dimensional conduction 

bands that can be applied to the energetic profile of planar graphene to reveal the 

electronic structure of the tube itself.  

Figure 1.4 shows the k-space representation of the graphite lattice with respect to 

these 1D conduction bands. When these bands intercept the k points (located at the six 
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vertices of the hexagon), free carriers are available for axial transport. Part a shows a 

metallic SWNT, where all Fermi points are intersected (red dots). Part b shows a lattice 

in which the conduction bands miss all Fermi points, resulting in a semiconducting tube. 

Below each representation is the shape of the energy band when overlayed on the conical 

dispersion relationship mentioned previously. When the conduction band approaches the 

Fermi point but does not meet it, the separation is representative of the band gap. Note 

the conical band shape. 

 

 

Figure 1.4 One-dimensional conduction bands with an overlayed k-space representation 
of (a) a metallic, or "armchair", nanotube and (b) a chiral nanotube. Red points represent 
Fermi points intersecting with conduction bands. Below each is the valence-conduction 
band character as the allowed bands are projected on the k-space energies. 

 

In general, SWNT exhibit metallic behavior when  

! 

2m + n = 3x     (Eq. 1.4) 
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where x is an integer. All other tubes will have some band gap, roughly of magnitude 

(0.7/dt) eV, where dt is the CNT diameter in nm[16]. It is notable that due to the four 

degenerate states in a SWNT (two spin states and two for directionality, or 

“handedness”), the maximum conductance of an individual metallic nanotube is expected 

to be 4 e2/h, or a resistance of ~6.5 kΩ. While this level of conductance has not yet been 

observed, measurements continue to approach it. 

MWNT exhibit the character of a small- or zero gap semiconductor regardless of 

the chirality of the outer layer. This is in part due to the inverse proportionality of the 

band gap to the tube diameter, Egap=(to ac-c)/d, where to is the tight binding overlap 

integral (2.7 eV), ac-c is the nearest carbon atom distance and d is the diameter[16]. At 

diameters of ~15 nm, the energy required to exceed the band gap is comparable to 

thermal energy at room temperature. It is also poorly understood how much neighboring 

shells interact with each other. Such interaction could make a larger number of states 

available to carriers, thus making a MWNT into a higher-order conductor than the 1D 

SWNT system, or the interaction could create a pseudogap in the density of states[19].  

 

1.5 Concerns in Real Nanotube Devices 
 

Possibly the primary concern when making electrical contact to nanotubes has 

been the formation of Schottky barriers. When a metal makes contact with a 

semiconductor, the Fermi energy levels must equilibrate through charge transfer. Because 

of the reduced mobility in the semiconductor, this causes a build up of charge at the 

interface, resulting in local bending of the electron energy bands and a potential barrier 

for carriers to overcome before transport can occur across the junction.  
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For n-type semiconductors, there is a buildup of positive charges at the junction 

(or, alternatively, an absence of negative carriers, hence the terminology depletion zone) 

as its higher Fermi level decreases to meet that of the metal (Fig. 1.5a). In this case, the 

height of the barrier φB is the difference between work function of the metal, φm, and the 

electron affinity of the semiconductor, χ[20]: 

! 

q"Bn = q("m # $)     (Eq. 1.5) 

where q is charge. The value φm is the energy difference between vacuum and the metal 

Fermi level while χ is the difference between vacuum and the bottom of the conduction 

band in the semiconductor. The resulting arrangement is rectifying to n carriers traveling 

from the semiconductor to the metal. 

For p-type semiconductors, the Fermi level must be raised to meet that of the 

metal (Fig. 1.5b), causing a buildup of negative charge at the junction (a p-type depletion 

zone). Here, the effect is reversed, rectifying p carriers from the semiconductor to the 

metal with a barrier of[20] 

! 

q"Bn = Eg # q("m # $)    (Eq. 1.6) 

where Eg is the energy across the band gap. The effect appears the same in both cases, 

due to the difference of carriers. 
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Figure 1.5 Schottky barrier formation for (a) a n-type and (b) a p-type semiconductor. In 
each is a representation of the energy structure before (left) and after (right) being 
brought into contact and in the lower right is a representation of the regions of charge 
buildup. 
 

In CNT devices, Schottky barriers are difficult to avoid. Even with metallic tubes, 

the existence of small amounts of contamination between the contacting metal and the 

tube can cause similar energy barriers because charge transfer is not unimpeded. Here, 

the barrier potential is the difference between the two work functions. Experimentally, 

the most success at attaining ohmic contacts has been through work function matching 

and thermal treatment. As shown in eqs. 1.5 and 1.6, the more closely matched the metal 

work function is to the electron affinity of semiconducting CNT (and indeed the work 

function of metallic CNT), the lower the energy barrier will be. Therefore, it has been 

demonstrated that Pd contacts yield the most ohmic behavior, followed by Au, Ti, etc[21, 

22]. Furthermore, thermal treatments have been shown to aid the contact[23], mostly 

through decomposition of contamination layers between CNT and the adjoining metal. 
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Once a CNT device is fabricated, the bands can also be manipulated through 

external fields, such as with a gate electrode. Transistor behavior has been demonstrated 

using SWNT[17, 24] showing a large gate dependence, wherein the conduction band of 

the tube is essentially bent by an applied field until a barrier is created or removed for 

transverse carriers (Fig. 1.6). As MWNT tend to be metallic (see section 1.X), field effect 

observed in those devices tend not to be related to intrinsic properties of the tube itself. 

So, further discussions will deal specifically with SWNT devices only. 

 

 

Figure 1.6 Ideal field effect on a p-type SWNT with Schottky barriers for (a) zero and 
(b) negative values of gate bias. Red areas in (b) indicate the small tunneling barrier that 
remains after band deflection. (c) Experimental data from a SWNT transistor[17]. 
 

The electric field effect (or transconductance) of a SWNT device is also strongly 

correlated to aspects of the device outside the material properties of the tube. Real 

devices are generally separated from the gate electrode by a dielectric layer (typically 

silicon oxide) of thickness z and permittivity ε. These values can be varied from one 

device to the next and doing so will be of importance later in this thesis (see Ch. 4). 

Therefore, it is useful to discuss how large the dependence of gate response on z and ε is.  

This examination begins by looking at the transport across the SWNT (source-drain), 

which follows Ohm’s law: 
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! 

V
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where σ is conductivity, A is cross sectional area and L is tube length. Conductivity can 

further be written as[20] 

! 

" =Qµ
n
    (Eq. 1.8) 

where Q is the total charge on the tube (Q=nq, where n is number of carriers and q is 

elementary charge) and µn is electron mobility. Now, because Q is related to capacitance 

C via Q=CV, it is clear that C has a direct relation with the measured conductivity of the 

SWNT.  

The capacitance C between the SWNT and the gate electrode is[25]  

! 

C =
4"#

o
L

2ln(2z /r)
     (Eq. 1.9) 

where ε is the permittivity of the material between, L is the tube length, z is the separation 

distance between the tube and the gate and r is tube radius. Therefore, comparisons can 

be made between three separate cases: (1) thin oxide devices, (2) thick oxide devices and 

(3) suspended devices (Fig. 1.7). Thin oxide is generally used in the aforementioned 

SWNT FET studies[17, 24], where a large field effect is desirable. The first model 

approximates this. The thick oxide model looks at the results of changing z and the 

suspended model examines a change in ε.  
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Figure 1.7 Three SWNT transistor models used to study the effect of device geometry on 
the field effect: (a) thin oxide, (b) thick oxide and (c) suspended. 
 

The only factor changing between cases 1 and 2 (for the same device geometry) is 

the oxide thickness z. So the ratio of the capacitances (and therefore the conductivities) 

for the two cases is 

! 

C2

C1

=
ln(2z1 /r)

ln(2z2 /r)
    (Eq. 1.10) 

As a test case, typical values are used for z1 (100 nm), z2 (1 µm) and r (1 nm), showing 

that a tenfold increase in distance z decreases the capacitance (i.e. measured conductivity) 

by only ~30%.  

In analyzing the effect of changing the permittivity ε (case 2 to case 3), the 

relation is simply 

! 

C
3

C
2

=
"
3

"
2

    (Eq. 1.11) 

Assuming ε3 is vacuum permittivity (εo) and ε2 is silicon oxide permittivity (3.8εo), 

removing the oxide decreases capacitance to nearly a quarter of its initial value. 

Therefore, the intervening material has a strong effect on the transconductance. 
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A final aspect of real devices that bares mention is the effect of surface charges on 

a contacted CNT device. Various ions can become deposited in the thermal oxide of a 

wafer as it is being formed[26]. These can cause a net positive charge in the material that 

can in turn induce a negative charge in the tube itself. Furthermore, at the boundary of the 

oxide and the bulk silicon, interface charges exist- a result of the Si+ ions left after 

oxidation. These can also contribute to induced charge. 

The first of these charge sources (ionic contamination) is nearly impossible to 

quantify without specific knowledge of the wafer fabrication. The second (interfacial 

charge), however, can be estimated to have a density of 1010 q/cm2 for {100} silicon[26]. 

The expected potential V caused by these interfacial charges is[27] 

! 

V =
z"

2#
    (Eq. 1.12) 

where z is separation distance, ρ is surface charge density and ε is the permittivity of the 

intervening space. Therefore, an uncertainty is added to the gate bias that varies directly 

with the density of charges caused by the dangling bonds. This relationship will be 

referred to in later chapters. 

 

1.6 Thesis Overview and Outline 
 
 

In Chapter 2 of this thesis, experimental methods and CNT torsional device 

geometry are discussed. Chapter 3 discusses resonant actuation of a MWNT torsional 

device. Chapter 4 concentrates on measurements of SWNT material properties using a 

torsional device. In Chapter 5, the use of the same type of device to study transport 

phenomena in a SWNT under applied shear strain is demonstrated. Chapter 6 discusses 
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the operation of SWNT torsional devices as oscillators in resonance. Finally, Chapter 7 

summarizes the thesis and discusses future directions and uses of the experiments.  



 
 
 
 
 

Chapter 2 
 

Experimental Technique and Design 
 

Though this be madness, yet there be method in’t. 
 

-William Shakespeare, Hamlet,  
  Act 2, scene 2 

 
 
2.1 Introduction 
 
 

The experiments detailed in this thesis have required a number of specialized 

fabrication and measurement techniques. Some of the methods are performed in a 

common manner, such as photolithography. These will be reviewed only briefly. 

However, other methods have been modified so as to allow for the highest quality device 

as a final product. These are the details that will be the focus of this chapter 

 
 
2.2 Carbon Nanotube Deposition 
 
 

While the specifics of the CNT deposition techniques used are somewhat well 

established, they bare mentioning in order to disclose the specific methods chosen for the 

present devices. 

For devices incorporating MWNT (not discussed in this thesis), raw material 

made with the laser ablation method[28] are used. Here, a target material composed 

largely of graphite and some catalyst particles (Co or Ni) is placed into a controlled 

furnace heat zone (900-1200 C) and a laser is used to evaporate the material. What results 
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is found to be up to 90% pure CNT. The material is then suspended in dichloromethane 

as nanotubes tend to suspend freely in nonpolar solvents such as this. In general, neither 

mass nor volume ratios are measured, but roughly 1 cm3 of raw material is added to ~30 

mL of solvent. Suspension density dictates the final density of nanotubes on a substrate 

and is adjusted to achieve the desired surface coverage. The MWNT suspension is then 

subjected to an ultrasonic treatment for an hour to break up densely packed bundles and 

result in a homogeneous mixture. 

For deposition onto a substrate, a drop of MWNT suspension is placed onto a 

substrate, followed by several drops of isoproponal. This addition changes the overall 

polarity of the solvent, causing the nanotubes to fall out of suspension and onto the 

underlying surface. After drying under nitrogen flow, the substrate is ready for further 

fabrication. 

SWNT can be produced in the same manner as MWNT in a laser ablation system 

through choice of catalyst particle, especially by using particles of smaller average 

diameter[29]. They are, however, more difficult to deposit from liquid. This is because 

their mass-to-surface area ratio is much lower than that of a MWNT, predominantly 

resulting in the formation of ropes rather than individual nanotubes due to Van der Waals 

interactions. This is avoided through the use of a surfactant method[30], wherein raw 

SWNT material is added to a 1% wt. solution of Sodium Dodecylsulfate (SDS) in water 

and exposed to a vigorous ultrasonic treatment (60-80 W) for an hour. This has the effect 

of breaking apart many of the ropes of material, which are then prevented from 

reconglomerating by the surfactant layer surrounding them. The suspension is then 

centrifuged for 60 minutes at 12,000 rpm, pulling most of the remaining ropes out of 
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suspension. The supernatent is then decanted and deposited onto a substrate spinning at 

2000 rpm. The surfactant layer is removed from the deposited material by deluging the 

surface with water. 

This liquid deposition technique does not deposit individual material with 

absolute certainty, however. In order to avoid these issues, this work preferentially uses 

SWNT grown directly on silicon substrates using a chemical vapor deposition (CVD) 

method. The central concern of CVD is the thermal decomposition of organic gas in a 

controlled environment and the catalysis of the decomposed material in order to produce 

SWNT. This requires catalyst particles (usually Fe- or Ni-containing) of very small 

diameter (<10 nm) or with asperities of a similar scale.  

The growth method used is discussed in detail in Appendix 1. In general, Fe/Mo 

catalyst particles[31] with diameters ~1 nm (or other similar sized, Fe-containing 

particles) were deposited directly onto a substrate by evaporation of a liquid suspension. 

Ideal catalyst density was determined in order to result in low nanotube coverage for 

device fabrication. The substrates were calcinated at 700 C in air for 10 minutes and then 

placed in a hydrogen flow (400 sccm). The temperature was raised to 900 C and the 

substrates were exposed to methane (800 sccm) and ethylene (5 sccm) for five minutes of 

growth, after which they were removed and processed. CVD using disperse catalyst 

particles is known to result in almost entirely individual nanotubes[29]. SWNT grown for 

this work have an average diameter of 0.97 nm (Fig. 2.1), further supporting this 

theorem. 
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Figure 2.1 Diameter distribution of SWNT grown by CVD directly onto a substrate, 
measured by AFM[32]. 

 
 

2.3 The Carbon Nanotube Torsional Device 
 
 

This thesis concentrates on a specific nanoelectromechanical device that utilizes 

an individual CNT as a torsional spring. The nanotube is suspended between two 

anchoring electrodes and supports a small metal block above the underlying substrate 

(Fig 2.2). This section will discuss the details of the fabrication process for this device 

architecture. Detailed methodologies pertaining to the particular equipment used in 

performing the experiments in this work is included in Appendix 2. 

 



 22 

 

Figure 2.2 Schematic of the CNT torsional device, wherein a torsional platform is 
suspended on an individual CNT between two metal anchors over a gap 
 
 

First, positive photolithography is performed on degenerately doped silicon 

wafers with thermally grown oxide layers of 0.6 to 1 µm. The procedure is commonly 

performed by spin coating a substrate (4000 rpm for 40 s.) with commercial photoresist 

(Shipley S1813). After baking the sample for 1 min. at 115 C to remove remnant solvent, 

it is allowed to cool before further processing. A mask aligner (Kasper) is then used to 

expose the resist to ultraviolet light (wavelength 365 nm) through a patterned glass mask. 

This has the effect of de-crosslinking the polymer network in the exposed regions and 

leaving them more susceptible to chemical treatment than unexposed areas. Exploiting 

this, a developer solution in then used to remove the de-crosslinked regions, resulting in a 

gutter to the underlying substrate in the otherwise unaffected resist. Following directional 

evaporation of metal (typically 10 nm Ti and 30 nm Au) onto the patterned wafer, all 

resist is removed with an acetone soak. Metal deposited atop the resist is removed with it, 

leaving substrate-bound areas only where exposure occurred. Negative photolithography, 

wherein exposed areas are crosslinked and metal remains in unexposed regions, can also 
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be performed to the same end using applicable resist and a negative mask, it was not used 

in this work 

In this way, the surface is patterned with eight individually addressable 

macroscopic electrodes that decrease in size to a small ~40 µm x 40 µm area where 

devices are to be fabricated (Fig. 2.3). Following this, the backside of the substrate is 

cleared of its oxide layer using a Hydrofluoric acid (HF) etch and coated with Al, to form 

a backgate electrode. Samples are then subjected to a thermal anneal of 350° in order to 

aid Al migration into the Si, thereby improving contact. Following this, CNT are 

deposited on the substrate using one of the methods described in section 2.2. In the cases 

where CVD is used to grow SWNT, the photolithography step is performed after growth 

to avoid the adverse effects of exposing the metal patterns to high temperature. The 

thermal treatment of the backgate is also performed in an Ar environment to avoid 

oxidation of the nanotubes. 

 

 

Figure 2.3 Schematic of the photolithography pattern with eight isolated leads 
 

In these cases, there are also frequently CNT bridging multiple leads (Fig. 2.4a). 

These are removed before subsequent steps by applying large bias between neighboring 
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electrodes under ambient conditions until conductance paths became immeasurable. This 

is found to correspond to oxidation of the bridging tubes (Fig 2.4b). The deposited CNT 

are then located with respect to the patterned metal and imaged using a scanning electron 

microscope (SEM) (Hitachi S-4700 FE). These images are used to perform electron beam 

lithography (EBL) on the substrates (see section 2.4), fabricating large anchor contacts on 

either end of a CNT and individually addressable electrical contacts to the eight isolated 

metal leads (Fig 2.4c). This step of EBL is also used to pattern small fiduciary marks on 

the substrate, to be used in subsequent steps. 

 

 

Figure 2.4 The fabrication process. (a) CVD-grown SWNT, connecting several overlying 
photolithographed leads. (b) Oxidative removal of connecting SWNT (circles indicate 
break points). Inset: representative conductance vs. applied bias between two leads. Each 
drop in conductance corresponds to removal of one or more tubes (more CNT connect 
leads outside of imaging field). (c) EBL-patterned anchors, contacts and fiduciary marks 
(cross-hairs). (d) EBL-patterned torsional platforms. Scale bars correspond to 10 µm. 
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Following metal deposition of the primary patterns, the device area is imaged 

once again to determine precise locations for all contacted CNT. A second step of EBL 

was performed to fabricate the small paddle structures onto the length of the CNT (Fig. 

2.4d). This step is aligned to the electron-beam defined fiduciary marks for high precision 

and is used to pattern only the smallest features of the devices, in order to avoid 

detrimental effects of drift during pattern exposure.  After metal deposition on the second 

patterning step, the substrate is exposed to a thermal anneal of 350-400 C under Ar flow, 

again, to prevent possible SWNT oxidation. This has the effect of thermally decomposing 

any remnant EBL resist polymer (and/or SDS, in pertinent devices) from the area 

between the nanotube and the contacting metal, resulting in improved contact. Following 

this, the sample is ready to be etched. 

The substrate is coated with a single layer of polymethyl methacylate (PMMA) 

(Mw = 996k), and standard EBL is used to define small squares over each device. Here, 

the patterned resist layer is used as an etch mask rather than a stencil for deposited metal. 

Buffered HF is then deposited onto the surface in order to chemically etch 0.5 to 1 µm of 

silicon oxide from it, depending on the original oxide thickness and, in some cases, the 

specific geometry of the devices. The PMMA protects the surface from the etchant 

everywhere except directly over the paddles, where the etch windows are defined. 

Devices can be fabricated successfully without using this extra step of EBL, but it is 

found that the procedure decreases possible leakage current between devices and the 

backgate electrode and makes the final devices more robust. 

Following etching, the substrate is submerged in acetone to remove the PMMA 

layer and then immediately dried using supercritical CO2. This prevents the devices from 
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being exposed to surface tension effects during evaporative drying, which generally cause 

them to fail. The final device is then complete (Fig 2.5) and ready for experimentation. 

 

 

Figure 2.5 Two fully suspended devices, viewed at approximately 30° to the substrate. 
Scale bar represents 1 µm. 

 
 
2.4 Electrically Contacting Nanotubes 
 
 

Obtaining low resistance electrical contact to SWNT is a difficult problem and 

has been the subject of much research. Many methods have been examined, such as 

choice of contacting metal[21] and using top- and bottom-contacts[33]. The work 

presented in this thesis uses a bilayer resist method and an annealing process to achieve 

low resistance electrical contact. The methods will be reviewed here; Appendix 2 gives 

step-by-step instructions of how they were performed.  

EBL is used to define contacting leads to individual nanotubes. EBL is very 

similar to photolithography, discussed in the previous section, except that PMMA is used 

as a resist. This polymer is sensitive to incident electrons in much the same way positive 

photoresist is sensitive to ultraviolet light, as exposure results in the de-crosslinking of 

the polymer. Development is then performed by using a 1:3 mixture of methyl isobutyl 
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ketone in isoproponol. Through the use of a SEM electron beam as an exposure source, 

however, the attainable resolution of patterns is drastically improved over 

photolithography, which is limited by the wavelength of the light. EBL can reliably 

produce sub-100 nm features, spatially positioned within 100 nm of a target area. 

 

Figure 2.6 Use of bilayer PMMA for electron beam lithography, resulting in desirable T-
structure (right) and low remnant material on the surface 
 

Common EBL resist is made using PMMA of Mw = 996k, but lower molecular 

weight polymer is more sensitive to electron beam exposure. Therefore, EBL can be 

performed on a bilayer resist composed of a layer of low Mw (350k) PMMA beneath a 

layer of standard Mw material (Fig. 2.6). Each type of PMMA are prepared by making a 

4% (wt.) solution of dry polymer in chlorobenzene. After being allowed to dissolve 

completely, a clear, only slightly viscous liquid results. The resist is deposited on a 

substrate via spin coating. Low Mw is deposited first, at a spin speed of 5000 rpm, and 

then subjected to a soft bake (180° C) for 2 minutes on a hot plate. This drives off 

remnant solvent and allows for a solid surface on which to deposit the second resist layer.  

High Mw PMMA is then spun at 4000 rpm, after which the sample is baked for ~1 hr. at 

180° C, this time using a tube furnace or enclosed oven. Application of ambient heat 
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results in more consistency within the layers and extended baking time is used to ensure 

total removal of solvent. 

The resulting devices incorporate the high-resolution device patterning of 

conventional EBL with decreased remnant resist left on the underlying surface (and 

nanotubes). Thermal evaporation is used to deposit first an adhesion layer (typically 5-10 

nm of Cr or Ti) and then a thicker contact layer (typically 80 nm Au) onto the patterned 

substrate. This is followed by a thermal anneal under Ar flow (see Section 2.3). 

Following this thermal treatment, SWNT contact resistances are generally found to be on 

the order of 100 kΩ, although values slightly lower than this have been measured. 



 
 
 
 
 

Chapter 3 
 

Experimental Measurement of Single-wall Carbon Nanotube  

Shear Moduli 

 
You can observe a lot just by watching 
 

-Yogi Berra 
 
 
3.1 Introduction 
 
 

One aspect of carbon nanotubes that make them attractive candidates for use in 

devices and composite materials is their amazing mechanical properties. As discussed in 

Ch. 1, they have larger mechanical moduli than diamond, making nanotubes the strongest 

material known. But, whether being used individually or en mass, the ultimate strength of 

any system incorporating CNT is linked to the strength of the individual tubes.  

A number of investigations have measured the axial and bending strength of 

CNT.  These investigations have primarily utilized techniques of oscillatory behavior and 

direct scanning probe manipulation and measurement. The former initially concentrated 

on monitoring thermal vibrations of cantilevered CNT with transmission electron 

microscopy (TEM) (Fig. 3.1a) and utilized MWNT or short SWNT, due to persistence 

length issues. By fitting the thermal amplitude over a range of temperatures, values for 

the Young’s modulus, Y, were extracted. For MWNT of various diameters, Y ranged from 

0.4-4.15 TPa with an average value of 1.8 TPa[8]. Similar measurements on short SWNT 
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yielded a similar range, though averaging to a lower (1.3 -0.4/+0.6) TPa[6] while doubly 

clamped CVD SWNT (Fig. 3.1b) showed Y ranging from. 0.02-2.6 TPa[4]. While these 

experiments overlapped with theoretical expectations, they contained obviously large 

error ranges.  

 

 

Figure 3.1 Thermal excitation of (a) a cantilevered MWNT[8] and (b) a doubly-clamped 
CVD SWNT[4] (inset: side view schematic). (c) Direct lateral scanning probe 
measurement on a cantilevered MWNT[9] (inset: manipulation schematic). 
 

Driven oscillations further elucidated the experimental measurement of Y. The 

methods used for this will be discussed in greater detail in Ch. 5, but the resonance 

frequency of individual oscillating CNT were measured and could be related to the 

Young’s modulus of the material through geometric values. MWNT of various 
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diameter[7, 34] and apparent quality[5] demonstrated a range of Y that was generally 

around 1 TPa with an inverse relation to diameter. 

The most direct measurements, however, are the use of an atomic force 

microscope (AFM) to directly contact individual CNT. Lateral Force microscopy of 

cantilevered MWNT (Fig. 3.1c) revealed Y=1.28 ±0.59 TPa[9]. Force measurements on 

SWNT ropes[35, 36] indicated values around 1 TPa with a bundle diameter dependence 

that decreased Y at larger diameters. Similar measurements on individual SWNT[37] 

yield values in high agreement with both the low diameter limit of the bundle values and 

theoretical expectations. 

While reasonably consistent across many material growth methods and 

measurement techniques, all previous studies have concentrated on axial strength as it is 

the most accessible dimension in which to actuate or apply strain. The 

nanoelectromechanical torsional device offered the first real ability to examine the third 

straining mode- that of twisting. 

The first measurements of this kind were performed on MWNT[14, 38], due to 

higher device stability and higher measurement threshold. Torsional devices were 

fabricated on individual MWNT and torsional properties were investigated through 

scanning probe measurements with a hybrid AFM/SEM system (Fig. 3.2a). Scanning 

probe-based force measurements require a probe spring constant matched closely to that 

of the object being measured, so the MWNT devices were studied with cantilevers of 

spring constant ~1 N/m. Values for measured shear moduli (Fig. 3.2b) agreed 

qualitatively with expected theoretical values of ~0.5 TPa[2]. More interestingly, 

however, a systematic increase in this measured value was found as the devices were 
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subjected to continued deflections (Fig 3.2c). This increase eventually saturated after 

hundreds of deflections. While several possible reasons for this effect were considered, 

including the result of imaging-beam induced contamination and changing mechanical 

contact at the points of CNT pinning, it was ultimately attributed to increasing 

interactions between the multiple graphitic shells that make up the MWNT. While some 

theoretical work supported this hypothesis[39], it was difficult to experimentally verify. 

 

 

Figure 3.2 Dependence of MWNT stiffness (measured by AFM; units of photodiode 
signal intensity per piezo distance) on number of deflections (from [14]) 
 

Further work on the MWNT-based torsional system utilized the paddle as an 

oscillator[40]. This work was performed by Papadakis, et al with contributions by the 

author of the current thesis. Here, devices were excited electrostatically (discussed later 

in this chapter) and deflection was measured with an optical interferometer at a pressure 

of ~10-5 Torr (Fig. 3.3a). While DC deflection (see next section) was observed (Fig. 

3.3b), the work concentrated on the frequency-dependent behavior of the system. In order 
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to drive the oscillations, a small, variable-frequency alternating signal was added to a DC 

offset and applied to the underlying substrate. In this way, it was shown that MWNT 

devices exhibit amplitude-dependent resonant torsional oscillations on the order of 1 

MHz (Fig. 3.3c and d). This behavior will be discussed further in the next chapter. 

 

 

Figure 3.3 (a) Schematic of the optical interferometer setup. (b) Measured DC deflection 
of a MWNT device and the resonant behavior of two devices showing both symmetric (c) 
and overdriven peaks. Bias is the applied DC component while the drive voltage is the 
amplitude of the oscillating signal. From [40], by Papadakis, Hall, et al. 
 

Because the resonance frequency Fo is related to the torsional spring constant Kθ 

by Kθ=(2πFo)2I, where the moment of inertia I of the paddle is estimated from direct 

geometric measurements of SEM images. From this, information inherent to the MWNT 

itself can be gained via the relation 
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where G is the CNT shear modulus, l is its exposed length and rout and rin are its outer and 

inner radius, respectively. While l and rout could be directly measured, rin could not, and 

in any event, the previous scanning probe-based measurements made it unclear how 

much interaction would occur between shells. Therefore, two limiting values for shear 

modulus were calculated: Ge, the solid rod model, and Gs, the thin shell model.  

 

Device Diameter (nm) ωo (MHz) Ge (GPa) Gs (GPa) 

1 12 1.68 90 570 

2 27 2.37 35 460 

3 28 2.50 54 740 

4 35 3.27 33 560 

5 16 2.92 435 3420 

6 20 3.79 290 2880 

7 18 4.12 565 5000 

8 22 2.98 200 2190 

9 21 2.04 120 1200 

Table 3.1 Measured values of diameter and resonant frequency (ωo) for nine MWNT 
devices and shear moduli for each, calculated with the solid rod model (Ge) and the thin 
shell model (Gs). Details in text. From [40], by Papadakis, Hall, et al. 
 

In the first model, total interaction among shells is assumed all the way to the 

center of the tube, while in the second, it is assumed that only the outermost shell is being 

torqued. From this, values for nine devices were gathered (Table 3.1). Interestingly, for 
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about half of the MWNT, Ge agreed best with experimental values while for the other 

half, Gs was in agreement. For one device, neither value was particularly close. This was 

taken to indicate that there could exist varying amounts of interaction amongst interior 

MWNT shells regardless of the number of deflections, as even the devices that indicated 

no interaction were actuated many millions of times. Therefore, the increasing interaction 

between shells (starting from the outermost and working inward) may continue through 

all layers or may stop at some particular layer. The reasons for this are unclear but may 

be related to specific registry between given shells or defect sites.  

One way to examine this phenomenon would be to study devices built on CNT of 

fewer shells, the lower limit being SWNT, thus removing inter-shell interactions from the 

system. This also would allow for experimental verification of the theoretical torsional 

mechanical properties of these simpler systems. However, some aspects of the 

experimental method make its application to SWNT difficult. Chief among them is the 

expected torsional spring constant, Kθ. Because of the large dependence of this value on 

nanotube radius, the spring constant of a SWNT device (rSWNT ~ 0.5 nm) is expected to be 

much lower (up to six orders of magnitude) than that of a similar device based on a 

MWNT (rMWNT ~ 15 nm). As mentioned above, spring constant matching is required for 

reliable scanning probe-based force measurements. The weakest commercially available 

cantilevers are only as low as ~.001 N/m, making such measurements on SWNT devices 

difficult if not impossible. Further, interferometry was made difficult by a feature of the 

fabrication method of SWNT devices, as follows. Due to the lower rigidity of SWNT, 

turbulence during the drying procedure or indeed even thermal energy[41] can cause 

relatively large deflections of the device. For this reason, the paddle itself must be made 
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much smaller than those built on MWNT in order to prevent it from touching the 

underlying substrate, after which Van der Walls forces make detachment impossible. 

This decrease in paddle surface area made optical measurements with the interferometer 

(spot size ~0.7 µm) difficult. Therefore, a new method must be used to advance these 

experiments. This chapter details this new method and the results obtained through its 

use. 

 

3.2 Experimental Methods  
 
 

An alternate to scanning probe actuation of the torsional device is electrostatic 

force actuation[42], which uses the underlying doped silicon wafer as a counter electrode 

to the torsional platform itself. In order to make the imaging of such actuation 

quantitative, the following methodology is used. 

 

Figure 3.4 Schematic of a torsional device (viewed from above) detailing the geometric 
values attainable from a SEM image.  

 

For a given device, a series of SEM images are taken perpendicular to the 

substrate. First, an image is taken of the device prior to actuation, from which device 

dimensions including SWNT lengths (l1 and l2), paddle length (lpad), paddle width (wpad) 



 37 

and distance to axis of rotation (daxis) are obtained (Fig. 3.4). After this, successive 

images of a device are taken at various static positions (that is, at various constant applied 

backgate voltages, and thus constant electrostatic forces). For each of these images (Fig. 

3.5a), the degree of deflection can be calculated from the projected image length of the 

paddle. For a given applied bias n, the apparent paddle width wn is measured. Using wn, 

the deflection angle can be deduced geometrically through the relation 
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as shown in Fig. 3.5b. Here, w0 is the width of the non-actuated paddle and θn is the 

deflection angle at n applied volts. 

 

 

Figure 3.5 (a) SEM images of a device viewed from above and labeled with apparent 
paddle width (red lines) at three actuation biases (scale bar= 500 nm). (b) Geometric 
relation between apparent paddle widths and deflection angle. (c) Applied backgate 
voltage vs. measured paddle deflection for a typical device. Dashed lines represent 
quadratic fit to data and maximum angle attainable with this device (90°) 
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This results in a quantitative relation between applied bias and deflection for each 

device (Fig. 3.5c). It is notable that these devices have a maximum deflection angle of 

nearly π/2 radians, or perpendicular to the substrate. This is because the paddle is thin 

and asymmetric to the SWNT axis, placing the centroid of charge on nearly the same z 

plane as the tube prior to deflection. When the centroid is between the nanotube and the 

gate electrode, increased electrostatic attraction force can only contribute to lateral force 

rather than torque. In later devices, the maximum deflection was increased to nearly π 

radians through simple geometric means that will be discussed in Ch. 4. 

 
 

3.3 Device Modeling and Analysis  
 
 

With the quantitative information from analysis of the static images (Fig. 3.5a) 

and AFM measurements of actual etch depth, an accurate computer model of each 

actuated device was built (Fig. 3.6). These models included both precise location of 

device components in relation to one another as well as inherent properties of the 

materials used (for instance, the permittivity ε of SiO2 compared to that of vacuum). The 

SWNT itself, however, is not included in the model as it was assumed from its size that it 

did not perturb the field significantly. Also not included in the model were slight 

irregularities, such as in metal edge smoothness, (as these were assumed to average out) 

and oxide surface states, which will be discussed in the next section. The computer model 

was then used to perform Finite Element (FE) analysis of the device in question. 

Examples of the calculated electric potential of a typical device are shown in Fig. 3.6.  
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Figure 3.6 (a) FE calculated electric field potential at three deflection angles (viewed 
along the nanotube axis). These correspond to the SEM images in Fig. 3.5a. (b) Labeled 
FE model and overlaid color map of FE calculated electric field potential. Full color scale 
is 4 V. From [32], by Hall, et al. 
 

From this simulation, surface charge density (ρ) at each point on the surface of a 

paddle is calculated through 

  

! 

" = #
o

v 
E $ ˆ n     (Eq. 3.3) 

where εo is the vacuum permittivity, n̂  is the local unit vector perpendicular to the paddle 

surface and     
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E  is the electric field calculated with the FE program. The force on an 

infinitesimal area dA of the paddle surface is  
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The paddle is a conductor, so the incident electrostatic field nEEsurf ˆ=
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 must be normal to 

its surface. Therefore 
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The portion of the total torque on the paddle contributed by dA is FdRTd
vvv

!=  where R 

is the distance of dA from the SWNT axis. Therefore, the total electrostatic torque on the 

paddle is given by the surface integral 
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The model of the paddle has six distinct surfaces (Fig. 3.7a) on which individual 

calculations can be performed to obtain the contribution of each to the net torque. Four 

faces of the paddle (top, bottom and two ends) experience forces that contribute to this 

net value. Forces on the sides of the paddle (facing the anchors) have no component 

perpendicular to the axis of rotation and thus do not contribute. It was found that the 

contribution of one surface for this paddle shape (surface 4) dominates the total torque 

acting on the system (Fig. 3.7b). Nonetheless, the electrostatic torque calculation was the 

sum of the surface integrals of all six surfaces.  

 

Figure 3.7 (a) Diagram[32] showing the six relevant faces in the FE model. (b) 
Calculated total torque and incremental torque acting on each face of a typical device for 
multiple applied biases. Inset: Electrostatic forces (dashed lines) and the components of 
those forces acting as a torque on each face. Light gray lines indicate moment arm 
relative to axis of rotation. 
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The net torque, T, varied with the applied bias, but was typically on the order of 10-18 

N m for the devices studied. This value is related to the shear modulus, G, of the SWNT 

spring through the equation[43] 

!"tr
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21 )( +
=     (Eq. 3.7) 

where l1 and l2 are the nanotube length to the left and right of the paddle, respectively, r is 

the nanotube radius, θ is the deflection angle and t is the wall thickness. The value used 

for t was 3.4 Å- an estimate of the graphene thickness based on the distance between 

layers in bulk graphite[2]. Other theoretical treatments[44] of SWNT use a thickness 

value as low as 0.66 Å. Error resulting from this would be negligible compared to error 

from other sources, such as the measurement of nanotube radius (see next section). 

 

 

3.4 Results and Discussion 
 
 

The resulting data showed the torsional spring behavior of individual SWNT (Fig. 

3.8a). By averaging all measured values for a particular device, we arrive at a value G for 

the SWNT that it was built upon. For larger applied torque, T, the measured deflection 

angle increased linearly, indicating Hookean behavior (following T=Kθθ). A plot of shear 

modulus G- related directly to Kθ, via eq. 3.1- at each deflection is shown in the inset of 

Fig. 3.8a, confirming this behavior. As the deflection limit of 90° is approached, the 

measurements deviate slightly from linearity, but are still within the error bars.  
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Figure 3.8 (a) Deflection angle vs. FE calculated torque for device 6 where 90 is the 
maximum deflection. Inset: Measured shear modulus vs. FE calculated toque for the 
same device. (b) Average SWNT shear modulus for six devices. Values are normalized to 
the average theoretical value (0.455 TPa) and the shaded region represents the range of 
values over all chiralities from Ref. [2]. Figure from [32], by Hall, et al. 
 

As shown in Fig. 3.8b, the inferred values are in agreement with theoretical 

predictions[2]. The average value for the shear moduli of all devices is G = 0.41 ± 0.36 

TPa.  The inset in Fig. 3.8a, shows that there is no detectable nonlinearity in the response, 

and from theoretical analysis[44], none is expected for the levels of strain applied here (< 

0.1 %). This merely indicates that the SWNT is not twisted enough to cause kinks in its 

cylindrical structure. Such an occurrence would be manifested as a large and sudden drop 

in the measured shear modulus due to a drop in the strain energy (Fig. 3.9a). In fact, the 

critical twisting angle before basic tube buckling should be[44] 

! 

"
c

= 2(1+#)$      (Eq. 3.8) 

where υ is Poisson’s ratio (~0.2). Such deflections are unattainable by any SWNT 

torsional system fabricated for this work. 
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Figure 3.9 (a) Calculated strain energy for increasing deflection angle of a 23nm long, 
1nm diameter SWNT. (b) Helical buckling pattern expected above 2.7 rad. Longer 
SWNT sections (like those found in the torsional device) would require even larger 
deflections before buckling occurs. From [44]. 
 

The largest error in the shear modulus measurements stems from the inability to 

measure the diameter of each SWNT accurately once the devices are suspended. 

Calculations are performed using a diameter equal to the measured mean diameter of the 

starting material (0.97 ±0.2nm). From measured distribution (see Chapter 2), we expect 

20% error, accounting for about 95% of all nanotubes on the surface. Differences in radii 

alone may be able to explain the statistical variation of shear modulus from one SWNT to 

the next. Other sources of error can be found in the dimensional measurements taken 

directly from SEM images and shape variation of the paddle, each about 10%. The 

significantly lower moduli (of samples 3 and 5, for example) could be due to increased 

defect density in those specific SWNT, or to the diameters’ being slightly more than one 

standard deviation above the mean. 

A final source of error lies in the possible surface states of the etched silicon 

oxide that underlies the device, as discussed in section 1.4. Eq 1.12 can be used to 
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quantify the effect of surface charge on the etched device, setting z equal to the 1 µm 

oxide thickness. The permittivity ε is set as (0.6εoxide+0.4εo) to account for the remaining 

oxide as well as the etched gap. The resulting potential difference (assuming a surface 

charge density ρ of 1010 q/cm2) is ~0.34 V, corresponding to an error in the bias of only 

about 5%. The actual surface charge density may be significantly lower due to charge 

passivation from being exposed to ambient conditions.  

Following DC actuation measurements, further investigation to deduce the cause 

of MWNT shear strengthening (section 3.1) was performed. An oscillating signal was 

applied to one device with a low frequency (<1 Hz) and of large enough amplitude to 

deflect the device to nearly 90°. The imaging beam was turned off for this procedure in 

order to remove any perturbation it may have caused. After several hundred cycles, the 

procedure to measure shear modulus was performed again. Despite the repeated 

deflections, the device showed no measurable change in reaction to applied field, giving 

the indication that the history-dependence of G is not present in similar systems built on 

SWNT. This supports the theory that the hysteretic behavior may be a product of 

interaction between interior graphene layers since none are present in the simplest single-

shell case. This will be the subject of future work with these devices (see Chapter 6). 



 
 
 
 
 

Chapter 4 
 

Electromechanical Response of Single-wall Carbon Nanotubes to 
Applied Torsional Strain 

 
 
Any sufficiently advanced technology is indistinguishable from magic. 
 

-Arthur C. Clarke 
 
 
4.1 Introduction 
 
 

It is well established that individual SWNT can exhibit a wide range of transport 

properties based upon their specific crystal structure (see section 1.4). But perhaps even 

more interesting than this is the anticipated dependence of the transport properties of a 

particular SWNT on external stimuli, such as strain. This phenomenon offers a means by 

which to monitor pertinent stimuli on the nanometer scale and opens the door for 

integrated nanoelectromechanical devices.  

The effect of strains on the properties of nanotubes has been widely studied in 

theory[45-50]. The effect of inducing strain on the carbon bonds is a distortion of the 

lattice from the graphene ideal that causes a shift of the Fermi points in relation to the 

allowable energy bands. It is the localization of the Fermi points with these 2D energy 

bands (k states) that is the prime factor deciding the band structure of the tube in 

question. Because the periodicity of the allowable energy bands is strongly correlated to 

the diameter of the tube (in so much as it depends on electron wavelengths that can fit 

around the circumference of the tube) and because this diameter is not strongly affected 
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by applied strains- especially small strains[49]- it is not a shift of these bands that is 

responsible for the expected change.  

In 2000, Yang and Han[50] used a Hückel tight-binding (TB) Hamiltonian to 

elucidate the effects of strain on the SWNT graphitic lattice. Similar calculations had 

previously been used to successfully predict the band structure of unstrained tubes[51, 

52] and here was used with the addition of a 2D strain tensor ε=(εij)2x2. 

The Hückel TB model for Fermi point kF takes the form of 

! 

H(kF ) = t j exp(ikF " a j0)# , where a0 is the carbon-carbon bond length and the sum is 

over j=1,2,3 for the three bonds to a given carbon atom. The variable tj is a Harrison 

hopping parameter of the form tj=t0(rj/r0)2 that accounts for the change in electron 

transport due to the deformed bonds (to is the tight-binding overlap integral, 2.7 eV). 

H(kF) is an energy term and is also equivalent to density of states energy E(kF), which 

will be important in the relation to the band structure. The expansion of |H(kF)|=0 to first 

order yields expressions for the circumferential shift in Fermi energy, ΔkF
c: 
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= 1+#( )$ cos3% + & sin3%    (Eq. 4.1) 

where υ is Poisson’s ratio, σ is axial strain, γ is torsional strain, and θ is the chiral angle. 

Through the use of energy equivalence (mentioned above) to find band energy for the 

initial kF location[51] and the strained  location, a relation of applied strains to the gap 

energy (between the first van Hove singularities, quantum number =1) is arrived at, of the 

form: 

! 

"Egap = sgn(2p +1)3to 1+#( )$ cos3% + & sin3%[ ]   (Eq. 4.2) 

Here, the variable p has a value of -1,0 or 1 such that n–m=3q+p is fulfilled, where q is 

an integer and m and n are the SWNT lattice indices. For semiconducting tubes, p=±1, 
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which means that the expected change in band gap can be either positive or negative. 

Metallic tubes (p=0) can only exhibit positive change, as required by their initial zero 

energy gap. The effect of both axial and torsional strain on the gaps of several types of 

SWNT is shown in Fig. 4.1. 

 

 

Figure 4.1 Theoretical dependence of SWNT band gap on (a) uniaxial and (b) torsional 
strain[50]. 
 

Prior to this, experiments were being performed to probe the effects of applied 

strain on nanotubes conductivity. Early atomic resolution scanning tunneling 

microscopy[53] observed a localized twist in a SWNT confined to a rope and speculated 

that such deformations could cause a semiconducting behavior observed in bundled 

material. In the earliest direct measurements[54], surface-bound MWNT were contacted 

on either end and a scanning probe was used to manipulate the tube laterally across the 

surface. While a repeatable and measurable change in resistance was observed, rigorous 

investigations on the levels of strain were not completed. While the results were 

somewhat frustrated by several aspects (including contact stability, surface interactions 
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and the use of the more complex MWNT system), they remain the first observable 

consequences of strain on nanotube transport.  

In later experiments, scanning probes were used elegantly to apply strains 

vertically to suspended SWNT. First, simple displacement dependence of an individual 

tube’s resistance was demonstrated with high reproducibility[55]. Soon after, the use of 

the scanning probe as a means by which to apply strain was extended to use as a gate 

electrode in order to characterize the transport characteristics of a given SWNT[56]. The 

latter work contains a quantitative treatment that will be reviewed here.  

To relate the measured resistance of a tube to its band structure, thermal 

excitations across the gap were considered and contributions of tunneling were neglected. 

For carriers of energy E such that (E-EF)>Egap, excitation across the gap will occur with a 

transmission probability |t|2, while those with energy (E-EF)<Egap cannot cross. The 

resulting relation was of the form 
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where Rc is the contact resistance in series with the SWNT. This is intended to hold for 

low bias source-drain measurements, where optical phonons, etc. are not a factor. 

The work in question found a distinct correlation between applied axial strain and 

transport properties and, importantly, observed different responses from different SWNT 

(Fig. 4.2). This result is in line with the previously mentioned theoretical works, which 

expect a dependence of the reaction on initial lattice arrangement. Agreement with the 

above exponential behavior was also observed (Fig. 4.2 insets), confirming its validity. 
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Figure 4.2 Experimental response of SWNT transport to axial strain for two different 
samples, demonstrating both (a) increasing and (b) decreasing resistance with added 
strain[56]. 
 

Several other experiments followed these works, exploring aspects of 

metallic/quasi-metallic/semiconducing tube response[57] and application to strain 

sensing technology[58]. However, these continued to concentrate on axial strain.  

The first study of torsional strain effects on transport were performed in 2006[59] 

on a system similar to the one presented in this thesis. In this work, suspended paddle 

elements were fabricated on MWNT and actuated directly with a scanning probe in a 

similar fashion to previously published methods[14]. Here, however, low-bias (10 mV) 

source-drain resistance was monitored during the actuation. In the resulting 

measurements, an oscillatory behavior was observed in the transport properties as the 

probe tip exerted a torque on the MWNT (Fig. 4.3). This was attributed to movement of 

the Fermi points through a number of allowable k states, the spacing of which were 

assumed narrow due to the large diameter of the tube. Total loss of conductance was also 

recorded at large deflection and attributed to breakage of the tube. 
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Figure 4.3 Oscillations in MWNT transport measured experimentally with a torsional 
device geometry[59]. 

 
Issues, however, abounded with this experimental setup, the most notable of 

which was the use of MWNT. During the course of the experiment, it was assumed that 

all transport occurred through the outermost graphene shell and that at no point did 

interior shells interact, even at large deflections. This was not supported by some 

previous work[14], although, as mentioned in section 3.1, varying degrees of interaction 

probably exist for different MWNT. The use of the scanning probe as a means by which 

to apply the strain may have also been problematic, allowing for possible perturbations 

due to additional charges, tip contact stability, etc. The work presented in this chapter 

seeks to remedy- or at least to lessen- these concerns and build upon the work covered 

briefly in this section. 

 

4.2 Experimental Methods 
 
 

Torsional devices were fabricated in the method detailed earlier in this thesis 

(section 2.3), ensuring the best electrical contact possible was achieved (section 2.4). 

CVD-grown SWNT were used in the process, immediately simplifying the experiment 

from its MWNT-based forerunner. Geometrically, the exposed length of SWNT on either 

side of the paddle was purposefully kept small by using high-resolution EBL techniques. 
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Lengths as low as 100-150 nm could be reliably attained in this way. The reason for this 

was to maximize the amount of torsional strain applied to the tube for a given rotation of 

the paddle as torsional strain in the SWNT sections goes as γ=rθ/l, where r is radius, θ is 

paddle deflection and l is the tube section length. 

The paddles were actuated using electrostatic attraction forces (Ch. 3), replacing 

the scanning probe method of strain application and its perturbative effects mentioned in 

the previous section. The paddle itself was fabricated in such a way that its thickness was 

large compared to its width (in the direction perpendicular to the tube axis). In previous 

thinner devices (see section 3.2), the maximum deflection attainable was about π/2 

radians because the centroid of charge was at nearly the same initial height as the SWNT 

axis (Fig. 4.4a); the fact that it was off-axis was the main cause of the torque. Thicker 

paddles shift the centroid above the axis of the nanotube, thereby allowing for deflections 

of nearly π radians (Fig. 4.4b). 

As discussed in section 1.4, surface charges on the underlying substrate can add 

uncertainty to the gate bias values, and since a larger amount of oxide is removed in the 

etching of these devices than was for the devices presented in the previous chapter, the 

uncertainty could be somewhat larger. Assuming total removal of the oxide, the potential 

resulting from surface states could be as much as 0.9 V. Again, though, passivation is not 

accounted for, making this a maxima. 
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Figure 4.4 Schematics of paddle actuation, where there is an increasing electrostatic 
force between the substrate (green) and the paddle (yellow) from left to right. Red dots 
represent the centroid of charge. Thin paddles (a) can only deflect around π/2 radians 
while thicker paddles (b) can attain nearly π radians. 

 
The total torsional measurement technique is shown in Fig. 4.5. Generally, SWNT 

transport was monitored as a DC bias was applied to the backgate electrode beneath. 

Importantly, these measurements were performed prior to high magnification SEM 

imaging of the devices. Incident electron beams have been shown to have an adverse 

(and, in some cases, controllable[60]) effect on CNT structure and transport 

properties[61]. This was found to diminish or to remove the measurable torsional 

response. After transport measurements, a series of SEM images were taken of a given 

device from above over a range of backgate biases, both positive and negative. Analysis 

of the projected width of the paddle allowed for a measure of its deflection angle at the 
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given gate value (see eq. 3.2). Because these thicker paddles can achieve large deflection 

angles, care must be taken to assure the correct widths are being measured from the static 

images (Fig. 4.6). 

 

Figure 4.5 Schematic of the self-contained system for the simultaneous measuring of 
SWNT transport and electrostatic application of torque. 
 

Assuming that the source-drain voltage drops linearly along the length of the tube, 

we expect that the actual voltage Vtot between the paddle and the gate is VBG - (VS-D⋅l1/( 

l1+l2)) and the electrostatic force between the entire paddle and the substrate is then 

! 

FES =
"wpad lpad

tsub
2

Vtot

2    (Eq. 4.4) 

where tsub is the distance from the paddle to the substrate below (in this case, the original 

oxide thickness). Because FES is proportional to torque and thus to paddle deflection, this 

indicates that θ∝ Vtot
2. This will be used in the analysis of the results.  
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Figure 4.6 (a-e) A thick paddle from 0 to 8 V applied gate bias (each image increases by 
2 V). Past π radians, the positive width of the paddle (blue) is measured in negative 
values (red) along the same surface. Scale bars represent 500 nm. (c) Backgate bias vs. 
deflection angle for a typical device with a quadratic fit. 

 

Measurement of the resistance response before etching (when the paddle is not 

free to rotate) allows separation of the torsional response of the SWNT from any field 

effect (transconductance) in the much longer static sections. This field effect on the 

etched device would be expected to be even smaller than the dependence prior to etching, 

as the dielectric constant of the vacuum gap was much lower than the silicon oxide layer 

(see section 1.4). 

The resistance response and measured deflection for two different SWNT devices 

are displayed in Fig. 4.7. The responses prior to etching are plotted on the same axes. 

Over many devices, the latter response ranged from slightly n-type to slightly p-type (Fig. 

4.8). This is probably due to a competition between band bending at the metal-nanotube 

junctions (n-type) and the inherent[62] behavior of semiconducting SWNT (p-type). In 

all cases, measured transconductance was small, on the order of ΔR ≤ 10% (Fig. 4.8). 
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This can be partially explained by the large oxide thickness (1 µm) and modest applied 

backgate biases, as discussed in section 1.4. The relatively high contact resistance is 

another likely cause. Furthermore, no SWNT demonstrated transconductance that was 

ambisymmetric about 0 V before release.  

 

 

Figure 4.7 Deflection (open circles) and measured differential resistance before (red) and 
after (blue) etching vs. applied backgate bias for two different SWNT. Both increasing 
(a) and decreasing (b) resistance was observed for added deflection. Insets: I-V 
characteristics of each device. 

 
After etching, however, the measured resistance changed with the paddle 

deflection. The rough symmetry about 0V is consistent with torsional strain as the 

stimulus for the effect, as the application of either positive or negative bias to the 

backgate results in a net torque in the same direction and thus the same strain in the 

SWNT. Importantly, some devices demonstrated an increase in source-drain resistance 

when deflected (Fig. 4.7a) while others demonstrated a decrease in the same value (Fig. 

4.7b). Measurements were performed in both high- and low-bias source-drain regimes 

and no qualitative difference was observed. This indicates that optical phonons do not 

play a significant role in transport for these devices. High bias measurements were 
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generally performed on the order of 1VS-D (Keithley 2400), while the low bias 

measurements were on the order of 10 mVS-D (EG&G lock-in amplifier). 

 

 

Figure 4.8 Typical gate response of two SWNT demonstrating slight n-type (black) and 
slight p-type (red) behavior. 

 

One alternative origin suggested for the measured transport change could be 

physical alteration of the metal-SWNT contact at either anchor electrode. This could be 

induced by electrostatic deflection of the tube changing its contact to the metal 

electrodes. This, however, is an unlikely explanation. Because the nanotube is buried 

under the deposited metal leads, electrostatic attraction should only be capable of 

deflecting the tube down toward the substrate and away from the lead. While this could 

explain an increase in resistance, the observed decrease in resistance for some devices 

cannot be accounted for. Furthermore, in devices fabricated with longer exposed SWNT 

on either side of the paddle, no effect was observed. While such devices would still be 

affected by possible changes to the nanotube contact, the torsional strain applied to the 

tube for the same paddle deflection would be dramatically reduced. 
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4.3 Results and Discussion 
 
 

A second order polynomial is fit to the raw backgate bias vs. deflection data (Fig. 

4.6f) in order to get an expression relating the two. This expression is applied to the 

source-drain transport vs. backgate bias data (Fig. 4.7, blue lines) in order to attain 

source-drain differential resistance vs. deflection angle. The exposed SWNT lengths in a 

device- l1 and l2, to the right and left of the paddle, respectively- are then obtained 

through measuring directly from SEM images. Source-drain differential resistance vs. 

strain γ in either SWNT section can then be gained through the relation γ=dl/2θ, where θ 

is the deflection angle and d is the nanotube diameter. Because direct measurement of 

tube diameter was difficult and in many cases added contamination to the system, the 

radius used in this calculation was the mean SWNT radius (0.49 nm) from the AFM-

measured distribution of the CVD method (Fig. 2.1). As in Ch. 3, 20% uncertainty 

accounts for ~95% of all tubes present on the substrate.  

A plot of the SWNT torsional strain against measured source-drain resistance 

reveals that a variety of responses are observed for different tubes. Fig. 4.9 shows the 

measured response for six different SWNT, plotted against the strain in the shorter 

exposed length of tube only in order to fit on the same axes. Following past work on 

strain-induced transport changes, these trends are associated with changes in the nanotube 

band gap. The insets show the I-V characteristics of two devices. All nanotubes that 

demonstrated a decrease in measured resistance showed some nonlinearity in this sweep, 

while those that indicated an increase in resistance varied in their linearity (Fig. 4.10). 
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This also agrees with the torsional mechanism, as a tube with no initial band gap (ie 

linear I-V characteristics) cannot experience a decrease in the energetic width of this gap. 

 

 

Figure 4.9 Torsional strain (in shorter SWNT section) vs. differential resistance for six 
different devices demonstrating the side variety of observed reactions. Insets: examples 
of I-V characteristics for two displayed devices (color indicated). 
 

Further analysis can be performed on data of this kind by referring to the relation 

between measured SWNT resistance and expected gap energy[37, 56], as discussed in 

section 4.1. For this system, Eq. 4.1 can be rewritten as 

! 

dEg

d"
= sgn(2p +1)3to sin3#(m,n)    (Eq. 4.5) 

It is assumed for this expression that axial strain in the system is negligible. Due to the 

fact that the Young’s modulus (0.97 TPa) is much larger than the shear modulus (~0.45 

TPa)[2], this estimation is warranted. 
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Figure 4.10 For all devices in Fig. 4.7, normalized linearity of the I-V response vs. 
measured change in differential resistance per unit applied strain. Linearity is measured 
through the r2 value- in this case, a statistical measure of how well the I-V data points 
match to a linear fit, scaled between 0 and 1. A value of 1 is a perfect fit. Linear response 
(red) implies metallic behavior while nonlinearity (black) implies semiconductor 
behavior. 

 
The total measured resistance of the system is 
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    (Eq. 4.6) 

where RC is the total contact resistance between the metal leads and the nanotube and 

RNT1 and RNT2 are the resistance contributions of each SWNT section. Using this relation 

along with Eq. 4.2 and 4.4, the measured differential resistance of the device can be 

correlated with the torsional strains in each section of nanotube through 
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Note that the strain on one side of the paddle will tend to compensate the response from 

the section on the other side. Because Eq. 4.2 does not account for tunneling across the 

band gap, this equation is most suitable for low source-drain bias measurements, so it is 

fit to a lock-in measurement (amplitude 50 mV) as shown in Fig. 4.11. In doing so, 
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further insight is gained into the nanotube structure. The change in resistance due to 

etching was 10 MΩ, which is attributed to a decrease in contact between the SWNT and 

the metal leads. The decrease could be caused by a number of factors including changes 

in mechanical pinning at the anchor lead or oxidation of the contacting metal. But, in 

general, because the measured resistances of the nanotubes prior to etching are much 

lower than after (Fig. 4.12), the change is considered to be an estimate of the total contact 

resistance Rc. The remaining parameters of |t|2, Eo and φ(m,n) are then to fit the data.  

 

 

Figure 4.11 Applied torsional strain in each SWNT section (l1 and l2, respectively) vs. 
measured differential resistance for a common device. Shaded region indicates error in 
the measured values and dashed line is a fit to Eq. 4.6. Inset: I-V characteristics of the 
SWNT. 
 

Fitting indicated that the presented SWNT agrees with an initial band gap energy 

of 29 meV and an estimated chiral angle φ of ~57°. Errors in our measurement- 

especially in nanotube radius- prevent high accuracy in this value and so these results are 

not meant to be quantitative. They do, however, demonstrate that the device acts as 
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expected if the change in measured transport was due to torsional strain. The fit also 

indicates a transmission probability |t|2 of 0.2, in agreement with other SWNT 

devices[56, 58]. However, varying this parameter over a large range did not affect the 

other values significantly, demonstrating its high uncertainty. 

 

 

Figure 4.12 I-V characteristics for a typical SWNT taken before (black) and after (red) 
etching, demonstrating the decrease in measured conductivity due to the process. 
 

This chapter has demonstrated that the torsional nanoelectromechanical device 

can be utilized as a means to apply a torsional strain to an individual SWNT and that this 

action can result in a measurable change in the transport properties of that tube. Several 

factors in the data indicate that the observed responses are in fact a product of the applied 

torsional strain. First, the gate dependence of the source-drain transport prior to etching 

was slight and non-ambisymmetric about VG=0V while after etching, the same 

measurement followed the torsional deflection of the paddle. Second, the degree of this 

reaction was found to vary widely between different SWNT, including both direct and 
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inverse relations. This was in agreement with theoretical expectations of torsional strain. 

Third, control experiments involving low applied torsional strain (i.e. long supporting 

SWNT lengths) showed no discernible gate dependence outside of field effect. Finally, 

the transport change was shown to act in a way that agrees with the expected reaction to 

torsional strain. 



 

 
 
 
 
 

Chapter 5 
 

Single-wall Carbon Nanotube Torsional Oscillators in Resonance 
 

 
Machines take me by surprise with great frequency 
 

-Alan Turing 
 
 
5.1 Introduction 
 
 

In essence, the CNT-based torsional nanoelectromechanical device is a mass on a 

doubly-clamped torsional spring. In the previous chapters, this has been employed to 

study the linear torsional mechanics of individual SWNT (Ch. 3) and to measure the 

effect of applied torsional strain on the resistance of a SWNT (Ch. 4). In this chapter, 

these two findings will be combined in order to realize a self-contained method for 

measuring the resonance of these devices. First, however, it is necessary to discuss 

oscillatory behavior in general[63], beginning with the simplest harmonic motion of a 

mass m on a linear spring of spring constant k.  

The force on the system when brought out of equilibrium is m

! 

˙ ̇ x (t) while the linear 

restoring force for this system is -kx(t). The forces can be set equal, resulting in the 

equation of motion 

! 

m˙ ̇ x (t) + kx(t) = 0     (Eq. 5.1) 

The solutions to this relation take the form of 
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x(t) = x
o
cos("

o
t + #)    (Eq. 5.2) 
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where xo is the initial position of the mass, t is time and δ is the phase of the oscillation. 

The variable ωo is 

! 

k
m

.  

Closer to reality is an oscillator that is subject to damping forces. The damping 

force is assumed to be proportional to the velocity 

! 

˙ x (t), such as in the case of friction. 

This is not always the case, but it allows for a linear equation of the form 

! 

˙ ̇ x (t) + 2"˙ x (t) +# 2
x(t) = Acos#t    (Eq. 5.3) 

where β is b/2m (b is a constant) and A is Fo/m (Fo is a driving force). This is for the case 

of sinusoidal driving. The particular solution to this variation of eq. 5.X takes the form of 
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where the factor preceding the cos(ωt-δ) function is the amplitude D of the oscillation 

and  
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The maximum amplitude of the system can be found when dD/dω=0. The 

resulting angular frequency ωR is the resonance frequency and can be expressed as 
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When β2 > ωo
2, the value of ωR is imaginary and thus does not exist. Fig. 5.1 shows 

calculated resonance behavior. The phase angle δ (or the phase between the application 

of driving signal and its reaction) varies from 0 when ω <<ωR to π when ω>>ωR, passing 

through π/2 at ωR. The amplitude increases until the resonance frequency and decreases 

after, producing the familiar peak associated with the phenomenon. 
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Figure 5.1 Calculated dependence of amplitude (black) and phase (red) on frequency. ωR 
set arbitrarily at 50 Hz. 

 

The quality factor, Q, of the oscillator is mathematically defined as 

! 

Q "
#

R

2$
     (Eq. 5.7) 

for β << ωo. Because of this relation to the factor β, Q is essentially a measure of the 

amount of damping in the oscillator- the greater the damping, the lower the Q. 

Qualitatively, it can be though of as the number of cycles a given system will keep 

oscillating after removal of a driving force. 

In terms of the resonance peak, the quality factor is a measure of how much larger 

the amplitude response is at the resonance frequency compared to the off-resonance 

behavior. It can thus also be defined for measured peaks as 
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where fR is the measured resonance frequency and Δ fFWHM is the peak width measured at 

half the total peak height. This measurement will be used later in this chapter to compare 

oscillators to one another. 

There are, of course, many damping effects that severely diminish the Q of real 

oscillators. Some of these damping factors have an even larger effect when the 

dimensions decrease, such as with NEMS devices. Some sources of damping will now be 

discussed in order to show later how they affect the SWNT torsional system. This 

treatment will concentrate on external effects as opposed to internal interactions (phonon-

phonon, electron-phonon, etc.), as they are dominant for a system on the scale of the 

SWNT torsional oscillator. One internal dissipation mechanism- the thermoelastic effect- 

however, is often a major source of loss in NEMS devices[64, 65] and so bares mention. 

As thermoelastic dissipation is a result of local volume changes in the oscillating 

structure, pure torsional deflection (such as is assumed for devices detailed later in this 

chapter) is considered a thermoelestically lossless mode. A more thorough discussion of 

both internal and external phenomena can be found in Ref. [61]. 

The first dissipation mechanism at work is the friction that arises from air 

resistance on the oscillator as it moves. Despite having very low surface area, interactions 

of this kind can play a role in damping. At low pressures, the mean free path of gas 

molecules can be larger than the size of a NEMS oscillator, and so the level of interaction 

becomes statistical. This effect has been quantified[66] as an energy loss per cycle Q-1 

through the relation 
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where p is pressure, A is the oscillator surface area, meff is its effective mass and ωo is its 

resonance frequency. The variable υ is the thermal velocity of the gas, calculated with 

! 

k
B
T

m
air

. At much higher pressures, this dependency changes (Fig. 5.2), but the work in 

this thesis deals only with low-pressure measurements.  

 

 

Figure 5.2 Dependence of Q on gas pressure, from reference [66]. 
 
 

A second dissipation mechanism is caused by the clamping of the oscillator at its 

interface with the mechanical supports. Here, acoustic energy can be lost in each cycle. 

Calculations involving this kind of dissipation have been limited to cantilever based 

systems. This is because multiple experimental data[67, 68] have concluded that 

clamping loss in torsional elements is negligible. While these findings were for 

micromechanical rather than nanomechanical resonators, it can be inferred that 

dissipation is similarly low in that regime.  

For an estimate, however, the most relevant cantilever relation is the general case of a 

finite thickness, which can be expressed as[69] 
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where w, t and l are width, thickness and length of the cantilever, respectively. Other 

calculations for clamping loss[70] make assumptions about the oscillator geometry 

(infinite width and equivalent thickness of the cantilever and the support, respectively) 

that make them less applicable to the oscillators being studied here.  

A final relevant loss source is ohmic dissipation resulting from capacitive 

coupling in a system being measured electrically. This source has been quantified for a 

similar system[61] as 

! 

Q
"1

=
(C'V )

2

#kC

$%

1+ ($% )2
& 

' 
( 

) 

* 
+    (Eq. 5.11) 

where C is capacitance (C’ being its spatial derivative), k is the resonator spring constant, 

ω is frequency and τ is the time constant RC.  

Each of these mechanisms will be estimated for measurements on SWNT 

torsional devices later in this chapter. 

 

 
5.2 Resonator Detection Schemes 
 
 

High-quality oscillators have found wide use in a variety of technologies, ranging 

from timing elements to sensors. The miniaturization of such devices can have several 

advantages, such as lowering power requirements, increasing sensitivity and introducing 

additional quantum effects that may enhance utility. Towards this end, conventional 

silicon processing technology has been pushed to its limit in recent years, resulting in 

truly nanoscale devices with sharp oscillatory behavior[71]. 
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As the critical dimension of these systems decrease, the means by which they can 

be monitored becomes an issue. Optical techniques have been a traditional approach to 

resonance measurement. Commonly in this method, laser light is reflected off both the 

resonator (measurement beam) and a stationary surface, such as the underlying substrate 

(reference beam). As the resonator moves, the measurement beam changes with respect 

to the reference, interfering constructively and destructively to varying degrees. By 

sensitively monitoring the sum of the two beams (hence the name ‘interferometry’), a 

measure of the instantaneous displacement of the device is made. When the resonance 

frequency is met, average displacement increases resulting in a peak in the measured 

beam intensity.  

This is the method used in the detection of MWNT torsional device resonance[40] 

(see section 4.1). The measurement apparatus (Fig. 3.3a) utilizes only a single beam for 

both measurement and reference, as the spot size is large enough to be incident on both 

the resonator and the underlying substrate. This method is applicable because devices 

built on MWNT can be fabricated with relatively large paddle dimensions (~1 µm). 

Those built on SWNT must be made somewhat smaller because the lower shear modulus 

results in larger amplitude thermal and mechanical vibrations. Paddles of larger 

dimensions can easily contact the underlying substrate, rendering them useless. As the 

size of the oscillator decreases to dimensions near that of the incident light wavelength, 

however, the method becomes less viable due to signal-to-noise limitations. As such, 

alternative measurement schemes must be used for devices at smallest, most interesting 

scales and many have been successfully demonstrated. 



 70 

The most intuitive of these is the direct observation of the oscillator amplitude by 

an imaging technique, such as electron microscopy[67]. In this case, device actuation is 

performed in situ (for example, electrostatically with a counter-electrode) and when 

resonance is met, the amplitude of oscillation is observed directly, often as a blurring of 

the moving part. While powerful in its simplicity, this measurement has several 

drawbacks. First, it can be dependent on the frame rate of the observation; in some cases, 

excitation may simply happen too quickly to be detected. Secondly, it is poorly 

understood how much the imaging beam itself affects the operation of the device. This is 

especially true as the scale decreases and other effects such as charging play a larger role. 

Finally, environmental parameters such as pressure and adsorbed gas cannot be varied as 

most nanoscale imaging techniques (SEM, TEM) have strict operating requirements. 

As such, many other more quantitative methods have also been used. Measuring 

the capacitance between a plate and a stationary component, for example, has been 

widely used in MEMS technology, especially with the aid of a multi-prong comb 

structure to increase the effect[72] (Fig. 5.3). Because the capacitance C is inversely 

related to plate separation d or overlapping area A through C=εA/d, the measurement is a 

sensitive determination of relative motion. Though challenging, the technique has been 

utilized for measuring nanometer-scale devices as well[73]. A variation on this theme in 

which an oscillator is coupled to a superconducting single electron transistor has also 

been demonstrated, reaching extremely high resolution in the measurement[74]. 
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Figure 5.3 Schematic illustration of capacitive displacement sensing in MEMS 
technology[72] 
 

Another quantitative measurement technique involves the use of electromotive 

force (EMF)[75]. Here, a doubly clamped beam (oscillator) is also used as a current 

carrying wire. A magnetic field is placed perpendicular to the beam orientation and a 

small AC current is introduced through the suspended beam structure. This causes a 

transverse Lorentzian force on the structure, which results in the oscillatory behavior of 

the device (Fig. 5.4). Beam actuation, in turn, induces an EMF that can be monitored 

electrically. This signal is maximized with maximum device amplitude. 

 

Figure 5.4 (a) Experimental method for measuring oscillation of amplitude with EMF 
and (b) and example of observed resonance peaks (EMF on y axis)[75]. 
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Intrinsic properties of the oscillator material can also be exploited for detection. 

For instance, the field emission properties have been used in measuring resonance in an 

individual cantilevered nanotube[76]. Here, a nearby anode was used to apply 

electrostatic forces to a strongly biased MWNT while an electron-sensitive screen (at 

ground relative to the MWNT) was used to monitor field emission (Fig. 5.5a). The 

emitted current is very strongly correlated to the tube-screen distance d through the 

Fowler-Nordheim equation[77]: 
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where V is the applied voltage, β is the field enhancement factor, ϕ is the tube work 

function and a and b are constants. Hence, the total emission current measured at the 

screen as the actuation frequency is swept reflects the oscillator amplitude (Fig. 5.5b). 

 

 

Figure 5.5 (a) Experimental setup for measuring MWNT resonance via field emission 
and (b) a resulting resonance peak measured through total emitted current at the electron 
sensitive screen[76]. 
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A second example that uses material properties is the measurable response of a 

piezoelectric material. Here, material deformation during oscillation is transduced to an 

electrical response by intrinsic properties of the device material. This is strongly tied to 

the methods discussed for devices later in this chapter. Though incorporated widely in 

MEMS technology[78, 79], the generally high resistance of NEMS results in frequency 

dependent attenuation in the MHz range. This has been overcome successfully by using a 

down-mixing method to convert the high resistance pathway to 50 Ω through the use of 

electronics before the signal reaches the device[80] (Fig. 5.6). Piezoelectric response also 

offers the advantage of an entirely integrated detection mechanism that is not dependent 

environmental conditions or external fields. 

 

 

Figure 5.6 Circuit diagram for the down-mixing technique used to measure resonance 
piezoresistively[80]. 
 

A final example of an actuation/detection system is the pioneering work 

performed by Sazonova, et al on doubly-clamped SWNT[61]. Here, they utilized the 

property of semiconducting SWNT that the charge on the tube body is directly correlated 

with its conductance. A suspended SWNT was actuated through a small AC signal (offset 
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from zero) applied to the backgate electrode. The relation for change in charge, δq, is as 

follows: 

! 

"q = "(CV ) = C"V +V"C    (Eq. 5.13) 

where C is capacitance and V is voltage (gate). The first term CδV occurred throughout 

the measurement because the actuation signal is alternating. The second term VδC, 

however, only occurred in the system when there is a change in the distance between the 

tube and the gate; this is the case for the increase in oscillation amplitude then resonance 

is met. The SWNT was used as a mixer in order to monitor the small change in source-

drain conductance that the capacitance effect caused, revealing resonance that could be 

tuned by changing the DC offset of the actuation signal (Fig. 5.7). 

 

 

Figure 5.7 Experimentally measured SWNT resonances (vertical slices are frequency 
sweeps) and their dependence on gate offset Vg, demonstrating device tunability[25]. 
 

In the previous chapter, the torsional strain transduction properties of SWNT were 

demonstrated. These could also be used as a means to directly measure resonant behavior 
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(Ch. 4). This chapter will concentrate on detection of torsional device oscillation in this 

manner.  

 

5.3 Experimental Methods 
 
 

Devices are fabricated as described previously (section 2.3) with thick paddles to 

allow for large deflection angles. For each sample, the transport properties and their 

reactions to applied torsional strain are characterized in the manner discussed in detail in 

Ch. 4. This allows for the determination of consistency throughout all subsequent 

measurements.  

Measurements of resonant behavior are performed in the vacuum of the SEM 

chamber (~10-5 Torr). Source-drain current is monitored with a low bias (50 mV) lock-in 

apparatus while a frequency-swept actuation signal is applied to the backgate electrode. 

This is accomplished through the use of a small (on the order of 100 mV) alternating 

signal, offset from zero (typically by 2-5V). The offset applies an initial deflection to the 

device, which has a twofold effect. First, it brings the centroid of the paddle close to the 

gate electrode, thereby increasing the electrostatic force resulting from the AC bias as the 

force has an inverse relation to the square of the separation distance (eq. 4.4). Second, it 

allows a symmetric reaction to the alternating signal; if it were to start from zero offset, 

the positive and negative portions of that signal would both cause attractive forces, 

doubling the effective frequency (Fig. 5.8). Offset voltages were used in other oscillator 

investigations[25, 40] for the same purpose. 
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Figure 5.8 Effect of DC offset on alternating actuation. With zero offset (a), the applied 
frequency of the actuating signal V is doubled because both positive and negative biases 
result in attractive forces. With offset voltage Voffset equal to or greater than half the 
actuation amplitude, the applied frequency is maintained in the force spectrum. 
 

As the actuation signal approaches the resonance frequency ωo, the amplitude of 

device oscillation increases as well such that the paddle is at a higher average deflection 

angle during that portion of the sweep. This translates to a measurable peak in the source-

drain resistance that is highly localized in the frequency spectrum. Fig. 5.9 shows an 

example of such a measurement that includes elucidation of the primary resonance peak 

as well as the first harmonic. Both peaks are high above the noise floor, have the same 

qualitative shape (Fig. 5.9 insets) and the harmonic occurs at ~2.1ωo. These three facts 

support the measurement as a mechanical resonance rather than an anomalous electrical 

peak, etc. There is ~8% error in the absolute frequency due to the measurement 

technique. Improving this measurement is of prime importance to future studies. 
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Figure 5.9 Measured change in SWNT differential resistance during a sweep of actuation 
frequency, showing both a resonance peak (~264 kHz) and the first harmonic (~530 
kHz). Insets are magnified views of the primary peak (left) and the first harmonic (right), 
demonstrating their similar shapes. 

 

The position of the main resonance peak offers a way to confirm the nature of the 

oscillation. A relation for the expected resonant frequency of the torsional mode has been 

shown[42]: 
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where κ is the torsional spring constant and I is the oscillator moment of inertia. Values 

for each of these can be inferred from measurements of the device images (see Fig. 3.4) 

and theoretical values for SWNT material properties. Upon doing so for the particular 

SWNT torsional oscillator measured for Fig. 5.9, the relation yields a value of 

ωo=358±125 kHz. The large error stems from the value for κ, which is proportional to 

rswnt
3. Nonetheless, the measured resonance peak occurs well within this range. 

Importantly, the resonance measurements also agree with the quasistatic 

electromechanical response in sign. As discussed in section 4.3, the same applied 
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torsional strain can affect the source-drain transport characteristics of different types of 

tubes in a range of ways- a twist can increase the resistance of some while decreasing the 

resistance of others, dependent on lattice orientation. Therefore, when utilizing the strain 

response to monitor device resonance, it is expected that the direction of the observed 

resonance peak could be either positive or negative in source-drain resistance, depending 

on the SWNT on which the particular device is built. Both reactions are observed and 

each agrees with the DC measurements taken before frequency-dependent actuation (Fig. 

5.10). This is further confirmation that the measured transport response is a direct result 

of torsional strain and not some other response.  

 

 

Figure 5.10 SWNT transport-strain dependence and measured resonance behavior for a 
two different nanotubes, one demonstrating (a) a direct relation and (b) an inverse 
relation between source-drain resistance and applied torsional strain (see section 4.3 for 
details). The direction of the peaks agrees with the respective DC deflection relation. 
Insets in differential resistance vs. strain plots are I-V behavior. 
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In order to verify the nature of the source-drain peak, however, an alternative 

method of measuring the mechanical resonance must be used. Optical interferometry is 

challenging for these devices because the surface area of the oscillating paddle is much 

smaller than that of previously measured MWNT devices- roughly 1/3 the size- critically 

decreasing the resolution of the technique (see previous section). Therefore, in situ 

imaging of the driven oscillator is used as a secondary measurement technique. 

 

 

Figure 5.11 SEM images of a paddle (initial gate bias of 2 VDC) with applied actuation 
frequency of (a) 245, (b) 257, (c) 276 kHz. The apparent width of the oscillator is larger  
on resonance (red bar in b) than off resonance (blue bars in a and b). Scale bar represents 
500 nm. 
 

For direct observation of resonance, the device is driven as stated above, but 

while simultaneously imaging it with the SEM. Importantly, this is performed after all 
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transport measurements on the device, as the incident electron beam was detrimental to 

the source-drain signal (see section 4.2). Similar to previously mentioned experiments[5, 

7], when resonance is met, the increase in oscillation manifests itself as a blurring of the 

suspended platform (Fig. 5.11). The apparent width of the paddle over a range of 

actuation frequencies is then used as a direct measurement of the amplitude of oscillation. 

When plotted on the same axes as the source-drain electrical signal, it is found that the 

peaks are coincident in the frequency spectrum within uncertainty mentioned above (Fig. 

5.12).  

 

 

Figure 5.12 Comparison of resonance measured by the SWNT electromechanical effect 
(solid line) to that observed by direct imaging (open circles). The latter is measured as the 
apparent width of the paddle structure as it blurs due to oscillation amplitude (see Fig. 
5.11). 
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The amplitude measurement from the SEM images is very wide compared to the 

electrical signal. This may be due to effects caused by the imaging beam, such as 

charging, amorphous carbon contamination or beam-induced damage to the carbon 

lattice, each of which could contribute to additional damping. These sources could also 

account for the somewhat lower resonance frequency observed with the imaging method, 

although uncertainty makes it difficult to know whether the difference is even real. 

In the next section, the observed resonant response of the SWNT torsional device 

will be analyzed further. 

 

 

5.4 Oscillator Behavior of a SWNT Torsional Device 

 
The resonant behavior of a SWNT torsional device is further studied by varying 

the amplitude of the alternating signal being applied to the gate electrode. As expected 

for a driven oscillator, the amplitude of the resonant oscillation (as related by the height 

of the resonance peak) is strongly dependent upon the amplitude of the driving signal. 

Fig. 5.13 shows the resulting peaks for drive amplitudes of 0.1, 0.3, 0.5 and 0.6 V (gate 

offset is 2 VDC). An asymmetric peak can be observed at a slightly larger applied 

amplitude of 0.7 V (Fig. 5.13 inset).  This section will characterize the measured 

amplitude-dependent response of a SWNT device. 
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Figure 5.13 Measured resonant behavior of a SWNT device at actuation amplitudes of 
0.1, 0.3, 0.5 and 0.6 V. Inset: response to a 0.7 V actuation amplitude, showing peak 
asymmetry (see text). 
 

It is clear from the figure that one side of the peaks is steeper than the other. This 

detail is an artifact of the measurement technique, wherein the frequency change of the 

applied signal is varied slightly faster than the source-drain data acquisition rate. 

Therefore, as frequency is swept, the leading edge of the peak rises quickly while the 

trailing edge falls slowly. It is especially noticeable between the 0.6 V peak (frequency 

swept from high to low) and the 0.5 V peak (frequency swept from low to high) in Fig. 

5.13. 

The height of a resonance peak is directly correlated with the maximum amplitude 

of device oscillation (see section 5.1). Because the deflection amplitude is directly related 

to the strain in the SWNT, a plot of the square of the drive signal amplitude against the 

maximum differential resistance is also essentially a representation of strain vs. resistance 
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(due to γ ∝ V2, following eq. 4.4). Interestingly, as Fig. 5.14 indicates, there is an 

exponential relation between these two factors. This is in qualitative agreement with 

many previous uniaxial SWNT piezoresistant measurements[56-58] (see eq. 4.3) and can 

therefore be viewed as further evidence of the torsional strain effect discussed in Ch. 4. 

Moreover, though, the exponential relation indicates that the SWNT torsional devices can 

be operated with high sensitivity using this measurement technique. 

 

 

Figure 5.14 Square of the actuation amplitude vs. maximum height of measured 
resonance peaks, indicating an exponential dependence. 

 

The specific reaction of the peak to the highest gate amplitude (0.7 V) is also of 

interest. It is possible that the observed response in this regime is a result of an inherent 

property of the SWNT. As the amplitude of oscillation approaches its largest value (at 

ωo), it may begin to induce enough strain on the SWNT to cause the band gap to begin to 

close again, as predicted in theory[50] (Fig. 5.15). This would result in a measured 

decrease in the differential resistance after the initial increase of the peak. It is unlikely 
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that the feature is a result of tube buckling, as eq. 3.8 makes clear, but the linearity of the 

oscillation at large amplitude is not well characterized. 

 

 

Figure 5.15 Theoretical relation of strain to band gap for three chiralities of SWNT, 
showing oscillatory behavior in the expected reaction[50]. 
 
 

The quality factor Q for the three symmetric and measurable peaks varied 

somewhat- 1150 for an applied amplitude of 0.6 V, 620 for 0.5 V and 430 for 0.3V. This 

may be a result of the aforementioned exponential relation between device amplitude and 

the source-drain transport that is used as a measurement technique. This will have the 

effect of stretching a peak in the y-axis, essentially increasing the effective Q artificially. 

While this feature may be useful in the application of the device, it could exaggerate the 

true mechanical Q of the oscillator.  
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Figure 5.16 Relation of current SWNT torsional device quality (average and range) to 
various other oscillators, showing good agreement with the expected trend. Adapted from 
Ref. [61]. 

 

An average value of the three measurable peaks is considered representative of 

the true device characteristics. Here, Q=740, which fits well with the general trend of 

oscillators based on volume (Fig. 5.16). It is also clear from this value that the external 

dissipation mechanisms discussed earlier in this chapter are not the major sources for 

energetic loss in the system. By applying values specific to the SWNT torsional device to 

each dissipation calculation, it is found that the associated losses are not large enough to 

overdamp the oscillator (Table 5.1). 
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Table 5.1 Calculated oscillator dissipation losses, adapted from [61] for the SWNT 
torsional device 
 

 

5.5 Results and Discussion 

 
In this chapter, it has been shown that the SWNT paddle device can be operated 

as a resonant torsional oscillator. Furthermore, this oscillatory behavior can be measured 

directly through the transduction properties that were detailed in Ch. 4, allowing for the 

assessment of resonant actuation with simple source-drain transport monitoring. 

Examination of observed resonance peaks yielded both further confirmation of the 

SWNT electromechanical response to strain and information about the device as an 

oscillator.  

The fact that resonance can be monitored in this way at all is corroborating 

evidence of torsional piezoresistivity. The oscillatory behavior itself was confirmed by 
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observing a higher order harmonic of the resonance (Fig. 5.9) as well as by measuring the 

frequency response through a secondary method of direct imaging (Figs. 5.11 and 5.12). 

Furthermore, the actuation amplitude dependence (Fig. 5.14) showed qualitatively that 

the transport response to torsional strain (much higher strains than can be applied through 

DC actuation, such as in Ch. 4) has an exponential dependence. This is in agreement with 

past results[56-58]. 

As an oscillator, the SWNT-based device exhibits a Q nearing 1000 and falling in 

line with the trend of past devices (Fig. 5.16). Calculations indicate that there is relatively 

little loss in the system (Table 5.1). 

 

 

 



 
 
 
 
 

Chapter 6 
 

Summary and Future Directions 
 

 
The Future is here. It’s just not widely distributed yet. 
 

-William Gibson 
 
 
6.1 Research Summary and Implications 
 
 

This thesis has presented experimental measurements on a number of a SWNT 

torsional nanoelectromechanical device, which utilizes an individual SWNT to support a 

small paddle above a substrate and between two anchoring electrodes. The device allows 

the nanotube to be used as a torsional spring. 

The mechanical reaction of such a device to applied electrostatic forces were 

deduced and through careful calculations to estimate the actual amount of torque acting 

on it, the first direct measurement of SWNT shear modulus was performed (Ch. 3). This 

line of experimentation demonstrated general agreement with theoretical calculations of 

the modulus and showed that the material acts as a linear torsional spring within the 

limits of strain applied through electrostatics. These results will be of importance to the 

incorporation of nanotubes into nanomechanical devices and may be expanded upon to 

have application in CNT-polymer composites. Furthermore, the measurement technique 

can be generalized to measure the torsional mechanical properties of a wide range of 

other nanometer-scale materials with applications in a wide range of areas. 
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Next, the device was used to examine the effect of applied strain on the transport 

properties of individual SWNT (Ch.4), as both theory[45-50] and experiment[54-58] 

have demonstrated. By monitoring source-drain resistance during the application of 

torque, a range of reactions was observed. This was in agreement with expectations and 

represented the first measurement of the torsional electromechanical response in a 

SWNT. The results of these experiments could have a wide range of application, from 

variable resistors in NEMS devices to characterization of the lattice structure of 

individual SWNT. 

Finally, the torsional device was operated as an oscillator (Ch. 5). By 

incorporating the strain sensitivity of the source-drain transport, it was shown that the 

system can operate as a self-sensing nanoscale resonator with a Q in the hundreds. The 

behavior was confirmed through a secondary measurement of the resonance and the 

amplitude-dependent response was examined. These results could have a great deal of 

use as a highly sensitive resonator and to all the applications that that entails.  

 

6.2 Future Directions and Aims 
 
 

The CNT torsional device geometry has proven to be an intriguing one, as 

demonstrated by the number of investigations[14, 32, 40, 41, 59, 81] that have been 

performed since its inception. As the experiments detailed in this thesis imply, however, 

there is still a large amount of knowledge to be gained from future work involving them. 

In this final section, some of these aims will be discussed. 

SWNT-based systems offer great promise in a variety of fields. First, 

improvements can be made to future generations of the devices (such as decreased 
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contact resistance to the tube and higher strain capabilities) that could allow for lower 

uncertainty in the measurements and better characterization of nanotube properties. 

Several analysis methods offer the ability to measure the fine structure of a particular 

SWNT either before or during application of torsional strain. These could include Raman 

spectroscopy[82], electron diffraction[83] or fluorescence microscopy[30]. Four-probe 

measurements could offer more confident elucidation of the changes in the inherent 

SWNT properties caused by torsional strain and recent advances[84] could allow for the 

fabrication and study of many devices built on tubes of a single chirality. Applications for 

well characterized devices of this kind could include electrical switching and varister 

components in NEMS. 

As a resonant oscillator, the SWNT torsional device offers a number of 

possibilities, especially due to its self-sensing characteristics. Among the most exciting 

could be its utility in the field of biological and chemical sensing. The paddle itself can 

be functionalized through thiol chemistry to be reactive with a large range of entities, 

which could lead to direct mass sensing through frequency shifting in the resonance peak. 

While challenges exist (such as the sensitivity of the SWNT itself to adsorbed 

molecules), the possibilities are enticing. 

The present body of work on the CNT torsional nanoelectromechanical system 

should be viewed as a beginning to a large set of investigations. This is a versatile 

platform for the study of CNT and nanomaterials in general. 
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APPENDIX 1: CHEMICAL VAPOR DEPOSITION TECHNIQUE 
 

The following section includes step-by-step instructions for performing CVD growth 

of SWNT for device fabrication. All flow rates and growth times have shown to be highly 

dependent on the specific apparatus being used; different systems may require significant 

variation in the values presented here. 

 

1) Cleave silicon into small pieces 

-Limited by the inner diameter of the tube furnace 

2) Solvent clean and UV/Plasma clean substrates 

3) Using Fe/Mo nanoparticle catalyst solution in hexane (dilute to 1/100k), deposit 

solution over entire surface and let evaporate 

-If using other catalyst or different initial concentration, may need to test several 

dilutions to find ideal amount 

4) Place sample(s) into tube furnace 

5) With no gas (air), anneal sample at 700 C for 10 min. (take into account ~5 min 

heating time) 

6) Allow to cool to below 200 C 

7) Hook up gas inlet and exhaust; turn on gas tanks at regulators 

8) One at a time, set flow rate of Hydrogen (400 sccm), Methane (800 sccm), and 

Ethelyne (5 sccm), and turn off each at switch  

9) Turn on Hydrogen and purge for 15 minutes to remove air (dangerous) 

10)  Keep Hydrogen on and turn temp to 900 C (10 min) 

11)  Turn on both Methane and Ethelyne (5 min) for growth 
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-Ensure flow rates at the beginning of the growth process 

12)  After growth, turn off Methane and Ethelyne; leave Hydrogen on and let flow 

13)  Reduce temp and wait until < 200 C to shut off Hydrogen and remove samples 
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APPENDIX 2: CARBON NANOTUBE TORSIONAL DEVICE 

FABRICATION DETAILS 

 

Following is the complete fabrication method for CNT-based torsional devices 

from bare wafer to suspended structure. The instructions are very specifically written for 

the following equipment: 

- Hitachi S-4700 FE Scanning Electron Microscope 

- Kasper UV mask aligner 

- Keithley 2400 sourcemeter 

- Nano Pattern Generation System (NPGS) Software (J. C. Nabity) 

- DesignCAD 

- Balzers Union CPD 020 critical point drying apparatus 

The details will vary with different systems, but the general order of steps can be 

maintained to result in working devices. 

 

 

**NOTE: if using CVD nanotube material, prepare nanotubes prior to all other 

processing by following Appendix 1** 

 

I. Photolithography 

 

1. Clean wafer 

- rinse with solvents and Nitrogen dry 
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2. Clean room prep 

- turn  on gas (house or tank) and vac pump  

- suit up, get 1813 resist from refrigerator, turn off light and enter 

yellow room (step on sticky mat on the way in) 

- press POWER and then LAMP START on lamp power box (you’ll 

hear squealing for a while) and power up mask aligner  

- turn on individual Nitrogen flow 

- set lamp to IDLE 

WHILE LAMP HEATS UP: 

3. Apply resist 

- set spin coater to 4000 rpm and 60 seconds, set hotplate to 115 C 

and set a timer to 1 min 

- place all samples onto hotplate for 5-10 min. covered with watch 

glass or beaker to drive off water vapor 

- line inside of spin coater tray with aluminum foil for clean up 

- remove one sample from heat and stick, unpolished side down, to 

spin coater chuck (with vacuum function or two sided tape) and fill 

10 mL beaker with resist 

- blow off sample with Nitrogen gun and pour on resist until entire 

surface is covered but not dripping off edges, start spinning and 

(once finished) move to hotplate and start the timer- remove after 1 

min 

- repeat for all samples 
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4. Exposure 

GENERAL OPERATION: 

- press MASK LOAD 

- lift metal holder and load mask 

- load sample 

- ensuring mask doesn’t fall before vacuum takes 

hold, lower metal holder 

- press LOADED MANUAL (SEP light comes on) 

- visually align sample 

- press CONT 

- set timer and press MANUAL EXPOSE 

BEFORE WAFER EXPOSURE: 

- prepare photometer (on bottom shelves under lamp power box) 

- put meter probe on exposure platform and switch timer on lamp to 

arbitrarily high number 

- load normally, except without a mask and expose 

- use photometer output to calculate exposure time based on “high 

resolution process parameters” (below) 

 

from Microposit user manual 
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- you can also check log for previous successful exposure times and 

use that 

- you may want to test parameters on a spare sample before exposing 

all wafers 

CHECK: 

- mask chrome (darker) side down? 

- if zif pattern, connective leads masked with tape? 

- make sure pattern edges parallel with wafer edges? 

- expose wafers 

5. Develop 

- prepare large beaker with 1813 developer and water (2:1) 

- wave sample gently in developer for 1 min.  

- rinse with water and GENTLY Nitrogen dry 

- MIX FRESH DEVELOPER after every 2-3 samples (developer 

becomes diluted) 

6. Metallize 

- deposit ~10 nm Cr or Ti and ~30nm Au with thermal or e-beam 

evaporator  

- thickness is important- photolith thickness should be LESS THAN 

that of future e-beam lith for superior contact to leads 

7. DO NOT LIFTOFF 

- by leaving the resist and metal on sample surface, the front of the 

sample remains protected from HF in next step 
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II. Backgating 

 

1. Oxide removal 

- Put some “Siloxide Etchant” or Hydrofuoric acid (HF) into a 

Teflon beaker  

- DO NOT use undiluted HF for this- the fumes alone can etch 

around to the sample side 

- place wafers exposed side up onto Teflon block 

- using plastic syringe (no needle), deposit etchant onto exposed side 

(do not create large bubble held onto surface by surface tension- 

small amount will suffice) 

- wait for etching (check rate) 

- once done, the etchant will dewet from silicon surface, balling up 

on oxidized areas 

- once entire surface is uniform, dip in water bath or spray 

LIGHTLY with deionized (DI) water into HF waste 

- Nitrogen dry 

2. Metallization 

- Thermally evaporate 100+ nm Al onto etched side (should be done 

immediately following removal of oxide) 

3. Liftoff of photolith 

- soak in acetone for at least 30 min. 

- use syringe/sonicator to remove excess metal 
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- Nitrogen dry 

- check with optical microscope  

4. Diffusion/Alloying bake 

- Use tube furnace with flowing Ar to bake all samples at 350 C for 

at least 30 min. 

 

III. Anchors/Fiducials 

 

NOTE: If NOT using CVD tubes, at this point (or preferably directly after 

fiducials) CNT should be deposited on sample surface 

 

1. Cleave wafer into individual playgrounds 

- place wafer, pattern up, on contact paper 

- using a glass slide (separated from wafer by another sheet of 

contact paper) as a template, make one small (~0.25”) scribe at one 

edge 

- flip sample and place on padded mat, covered by new contact paper 

and roll small metal rod over it (so the rod is parallel with the scribe 

and motion is perpendicular), pressing until sample breaks 

- spray with isopropanol (IPA), Nitrogen dry 

2. WITH CVD MATERIAL INTENDED FOR ELECTRICAL 

MEASUEMENTS ONLY: Tube Burning 
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- set Keithley for 10-20V and test the connection between each 

adjacent lead (1-2, 2-3….7-8,8-1) 

- when there is current greater than a few tens of pA, use ramping 

software (eg. VIcurve.vi) to ramp voltage across leads from zero to 

100 V 

- USE NEEDLE CONNECTORS and once connection fails (current 

drops to pA again), REMOVE VOLTAGE IMMEDIATELY (even 

if cycle isn’t complete)- otherwise could arc and destroy photolith 

pattern 

- also check connection between all leads and backgate, to ensure no 

leakage current- if so, repeat for those connections (may have to go 

up to 200 V) 

- rinse with IPA and Nitrogen dry 

3. Initial Imaging 

- image samples (capture): 

- 1 kV, 20uA 

- upper detector (column adjust) 

- Cond. Lens 1= 1 

- 1.3kX magnification 

- transfer images to NPGS-equipped computer 

4. OPTIONAL: Thermal treatment (removes soap layer and SEM 

contamination, further diffuses Al into silicon)  

*THIS CAN BE DONE WHILE MAKING THE CAD DRAWINGS* 
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- place samples in ceramic boat and push into tube furnace  

- ensure Ar flow through tube and begin cooling water flow 

- close both ends and allow Ar flow for ~5 min (to ensure no air) 

- set temperature to 350 C 

- once temperature is reached, let sit for 45 minutes 

- after time, set temperature to zero and allow to cool fully (lower 

than 100 C when removed) 

- shut off Ar, remove sample 

- rinse with IPA, Nitrogen dry 

5. CAD (for each) 

- choose File -> Image ->Load image file and select high resolution 

image 

- open paddle farm file, zif_fids file and zif_coarsealign file 

On high resolution image: 

- zoom on scale bar, hit “u”, set crosshairs at ends and input length 

scale 

- hit “v”, draw vectors to symmetrical areas of sample (fine 

alignment marks), zoom on intersection, go to Point->Origin and 

click on intersection point, and delete vector 

- copy appropriate paddle anchors and place them appropriately 

- make electrical leads (make no less than  2µm thick), starting from 

anchor and going to lead 

- copy zif_fids onto image and align 
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- copy coarse align windows onto image and align 

- delete SEM background image  

- delete devices and fids and NPGS-> Save what remains as 

*_aln.DC2 

- hit Edit -> Undo 

- delete alignment windows and NPGS-> Save what remains as 

*_dev.DC2 

6. Run file (for each) 

- in NPGS menu, go to Project -> Create New Project, add folder 

name where files were stored 

- in “run file editor”, set entities to 2, change first to alignment and 

input *-aln.DC2, input *_dev.DC2 for second 

FOR ALIGNMENT: 

- magnification = 800 

- measured beam current = 12 

- ls=2000 

FOR PATTERN: 

- magnification = 800 

- ls=300 

- measured beam current = 12 

- dose= 1.2 

7. FOR ELECTRICALLY CONTACTING TUBES ONLY (others simply 

skip this step): Bilayer PMMA 
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- set spin coater to 5000 rpm and 40 seconds, set hotplate with 

internal readout to 180 C and set a timer to 2 min 

- using dropper, deposit 4% PMMA (mwt = 350k) onto sample until 

entire surface is covered but not dripping off edges, start spinning 

and (once finished) move to hotplate 

- remove after 2 min 

8. PMMA coating (IF step 7 was skipped) 

- set spin coater to 4000 rpm and 40 seconds, set tube furnace to 180 

C 

- stick sample, backgate down, to spin coater chuck with two sided 

tape or carbon tape 

- using dropper, deposit 4% PMMA (mwt = 996k) onto sample until 

entire surface is covered but not dripping off edges, start spinning  

- bake in tube furnace for 1.5-2 hrs. 

- NOTE: when contact is less important, can substitute tube furnace 

for 2 min. on 180 C hotplate 

9. Exposure 

- put sample on Faraday cup stage and set SEM for 30 kV and 5 µA 

and go to faraday cup 

- set focus and stigma on edge of cup 

- set current in high mag mode (above 20k x) to appropriate current 

(check run file “measured current”) 

- move to playground and refocus on debris or metal edge 
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- set magnification (check run file “magnification”), switch control 

over to NPGS and process run file 

- switch control back to SEM; repeat for all samples 

10. Develop 

- Put small amount of PMMA developer (Methyl Isobutyl 

Ketone(MIBK):IPA, 1:3) in 10 mL beaker and set timer for 1:10 

(make sure it’s enough to submerge the sample area) 

- develop each sample, rinse with DI water and Nitrogen dry 

- check with optical microscope 

11. Metallize 

- deposit ~10 nm Cr or Ti and ~80nm Au with thermal or e-beam 

evaporator  

- THICKNESS SHOULD BE GREATER THAN THICKNESS OF 

PHOTOLITH 

12. Liftoff 

- soak in acetone for at least 15 min. 

- use syringe/sonicator to remove off excess metal 

- rinse with IPA, Nitrogen dry 

- check with optical microscope  

IV. Paddles  

1. Image samples 

- image samples (capture): 

- 1 kV, 20uA 
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- upper detector (column adjust) 

- 1.3kX magnification 

- transfer images to NPGS-equipped computer 

- store samples in acetone for cleanliness (rinse with IPA and 

Nitrogen dry before further use) 

2. CAD (for each) 

- choose File -> Image ->Load image file and select high resolution 

image 

- open zif_finealign file and paddle farm file 

On high resolution image: 

- zoom on scale bar, hit “u”, set crosshairs at ends and input length 

scale 

- hit “v”, draw vectors to symmetrical areas of sample (fine 

alignment marks), zoom on intersection, go to Point->Origin and 

click on intersection point, and delete vector 

- copy appropriate paddles (for SWNT, generally no longer than 

600nm) and place them appropriately 

- ONCE ALL PADDLES ARE ALGINED: select all paddles and 

move up and to the right (~45 degrees) 150-200nm to account for 

drift 

- copy fine align windows onto image and align 

- delete SEM background image  

- delete devices and NPGS-> Save what remains as *_aln.DC2 
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- hit Edit -> Undo 

- delete alignment windows and NPGS-> Save what remains as 

*_dev.DC2 

3. Run file (for each) 

- In NPGS menu, go to Project -> Create New Project, add folder 

name where files were stored 

- in “run file editor”, set entities to 2, change first to alignment and 

input *-aln.DC2, input *_dev.DC2 for second 

FOR ALIGNMENT: 

- magnification = 900 

- measured beam current = 12 

- layers 11 and 15 = Start New Set 

- ls(7-10)=2000 

- ls(11-14)=456 

- ls(15-18)=192 

FOR PATTERN: 

- magnification = 900 

- ls=300 

- measured beam current = 12 

- dose= 0.9 (for very small separation 

distances, values as low as 0.6 can be used) 

4. FOR ELECTRICALLY CONTACTING TUBES ONLY (others simply 

skip this step): Bilayer PMMA 
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- set spin coater to 5000 rpm and 40 seconds, set hotplate with 

internal readout to 180 C and set a timer to 2 min 

- using dropper, deposit 4% PMMA (mwt = 350k) onto sample until 

entire surface is covered but not dripping off edges, start spinning 

and (once finished) move to hotplate 

- remove after 2 min 

5. PMMA coating (IF step 4 was skipped) 

- set spin coater to 4000 rpm and 40 seconds, set tube furnace to 180 

C 

- stick sample, backgate down, to spin coater chuck with two sided 

tape or carbon tape 

- using dropper, deposit 4% PMMA (mwt = 996k) onto sample until 

entire surface is covered but not dripping off edges, start spinning  

- bake in tube furnace for 1.5-2 hrs. 

- NOTE: when contact is less important, can substitute tube furnace 

for 2 min. on 180 C hotplate 

6. Exposure (for each) 

- put sample on Faraday cup stage and set SEM for 30 kV and 5 µA 

and go to faraday cup 

- set focus and stigma on edge of cup 

- set current in high mag mode (above 20k x) to appropriate current 

(check run file “measured current”) 

- move to playground and refocus on debris or metal edge 
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- set magnification (check run file “magnification”), switch control 

over to NPGS and process run file 

- IMPORTANT: for the three steps in alignment cycle- align once to 

first, once to second, twice to third and IMMEDIATELY tell 

program to expose sample. This will prevent excess drift and 

consequently missing the CNT 

- switch control back to SEM; repeat for all samples 

7. Develop 

- Put small amount of PMMA developer (MIBK:IPA, 1:3) in 10 mL 

beaker and set timer for 1:10 (make sure it’s enough to submerge the 

sample area) 

- develop each sample, rinse with DI water and NITROGEN dry 

- check with optical microscope 

8. Metallize 

- deposit ~10 nm Cr and ~80 Au with thermal evaporator  

9. Liftoff 

- soak in acetone for at least 15 min. 

- use syringe or sonicator to remove excess metal 

- rinse with IPA, Nitrogen dry 

- check with optical microscope 

V. Etching 

NOTE: Steps 1-6 are for making etch widows for a highly localized etch- if this is 

not needed, skip to step 7  
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1. Image samples 

- image samples (capture): 

- 1 kV, 20uA 

- upper detector (column adjust) 

- 1.3kX magnification 

- transfer images to NPGS-equipped computer 

- store samples in acetone for cleanliness (rinse with IPA and 

Nitrogen dry before further use) 

2. CAD (for each) 

- choose File -> Image ->Load image file and select high resolution 

image 

- open zif_finealign file and paddle farm file 

On high resolution image: 

- zoom on scale bar, hit “u”, set crosshairs at ends and input length 

scale 

- hit “v”, draw vectors to symmetrical areas of sample (fine 

alignment marks), zoom on intersection, go to Point->Origin and 

click on intersection point, and delete vector 

- Draw line DIRECTLY over paddle (line width = 0.2) 

- ONCE ALL WINDOWS ARE ALGINED: select all paddles and 

move up and to the right (~45 degrees) 150-200nm to account for 

drift 
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- copy fine align windows onto image and align 

- delete SEM background image  

- delete devices and NPGS-> Save what remains as *_aln.DC2 

- hit Edit -> Undo 

- delete alignment windows and NPGS-> Save what remains as 

*_dev.DC2 

3. Run file (for each) 

- in NPGS menu, go to Project -> Create New Project, add folder 

name where files were stored 

- in “run file editor”, set entities to 2, change first to alignment and 

input *-aln.DC2, input *_dev.DC2 for second 

FOR ALIGNMENT: 

- magnification = 900 

- measured beam current = 12 

- layers 11 and 15 = Start New Set 

- ls(7-10)=2000 

- ls(11-14)=456 

- ls(15-18)=192 

FOR PATTERN: 

- magnification = 900 

- ls=300 

- measured beam current = 12 

- dose= 0.9 
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4. PMMA coating 

- set spin coater to 4000 rpm and 40 seconds, set tube furnace to 180 

C 

- stick sample, backgate down, to spin coater chuck with two sided 

tape or carbon tape 

- using dropper, deposit 4% PMMA (mwt = 996k) onto sample until 

entire surface is covered but not dripping off edges, start spinning  

- bake in tube furnace for 1.5-2 hrs. 

- NOTE: may be able to substitute tube furnace for 2 min. on 180 C 

hotplate 

5. Exposure (for each) 

- put sample on Faraday cup stage and set SEM for 30 kV and 5 µA 

and go to faraday cup 

- set focus and stigma on edge of cup 

- set current in high mag mode (above 20k x) to appropriate current 

(check run file “measured current”) 

- move to playground and refocus on debris or metal edge 

- set magnification (check run file “magnification”), switch control 

over to NPGS and process run file 

- IMPORTANT: for the three steps in alignment cycle- align once to 

first, once to second, twice to third and IMMEDIATELY tell 

program to expose sample. This will prevent excess drift and 

consequently missing the CNT 
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- switch control back to SEM; repeat for all samples 

6. Develop 

- Put small amount of PMMA developer (MIBK:IPA, 1:3) in 10 mL 

beaker and set timer for 1:10 (make sure it’s enough to submerge the 

sample area) 

- develop each sample, rinse with DI water and Nitrogen dry 

- check with optical microscope (may not be able to see) 

7. Test etch samples (when etch rate isn’t established) 

- scribe several (three or four) small pieces of silicon from the same 

wafer that your sample came from (preferably with photolith on 

them) 

- rinse with solvents  

- place small drop of Buffered HF (BHF) (or “siloxide etchant”) on 

each wafer and stop etch (with water bath after varying times (no 

need to exceed 10 min, usually) 

- use AFM to measure etch depth as metal edges (compared to 

original wafer) 

- calculate time for your sample etching 

8. Sample etching 

- pour a small amount of BHF solution into a small Teflon beaker 

and prepare a timer 

- use plastic syringe, place drops of BHF onto your sample (DO 

NOT spill over edge- will eat away backgate) 
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9. Etch stop 

- prepare large beaker of DI water and a storage jar of ethanol 

- remove working sample at desired etch depth 

- keep in mind that etch rate may be varied by the presence 

of materials (cnt, etc) or by contamination from previous 

imaging- judge accordingly 

- dip sample directly into DI water (do not let the liquid leave the 

surface of the sample; keep wet)  

- *IF USING ETCH WINDOWS: soak in acetone for AT LEAST 15 

min. to remove PMMA 

- remove and place in jar of ethanol for storage until critical point 

drying 

10. Critical point drying 

- make sure all three valves on critical point dryer are firmly 

closed 

- remove lid and pour ethanol in drying chamber until port hole is 

high enough to cover samples (judge by eye) 

- place small glass ring (flow protector) into chamber (and off to 

right), and inside ring put one of the curved-bottom ceramic pieces 

(broken tube furnace boat) 

- remove sample from jar and put directly into chamber ethanol 

(again, do not break surface tension on sample) and place FACE 
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DOWN in curved piece. If all samples don’t fit, ceramic pieces are 

stackable; close lid 

- open both tanks of CO2, push “MAINS” 

- push “TEMPERATURE” and set goal temperature to 15, let 

chamber cool 

- once cooled, open GAS IN knob (on left of machine) slightly and 

let port hole fill entirely 

- if it is filled to quickly, the turbulence may damage your 

samples 

- close GAS IN, open GAS OUT (right side front) several turns and 

then slowly open METERING VALVE (right side rear) to let liquid 

drain (do not let liquid level drop to the sample) 

- close both METERING VALVE and GAS OUT and repeat filling 

process (from “open GAS IN”, above) 4 or 5 times, until liquid is 

completely clear and all ethanol is replaced 

- make sure all valves are closed and close CO2tanks 

- set goal temperature to 45; transition will occur as pressure and 

temperature rise- watch port hole for it 

- after transition, open METERING VALVE several turns and open 

GAS OUT very slightly (should only have started to hear the gas 

coming out) 

- let pressure reduce; DO NOT let condensation occur (caused by 

letting out gas too fast) 
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- once pressure is atmospheric, close all valves, unscrew lid, remove 

sample, replace lid and log useage 
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